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1 Introduction

1.1 Description

LightMachine is a plugin for performing all kinds of light adjustments in photos. It combines shadow/highlight, virtual
lighting and color-based correction tools for performing sophisticated corrections without the need for time-consuming
selections and layer stacks. It lets you selectively correct photos taken under bad light conditions or with inadequate
camera settings and achieve results that rival photos taken under the best circumstances. Additionally LightMachine can
achieve special effects like glows, sunsets, high key and selective b/w effects, replace one color with another and
simulate polarizing filters.

LightMachine is available as a Photoshop-compatible plugin for Windows and MacOS X as well as a standalone
application and Lightroom external editor for Windows. The plugin works in dozens of graphics applications, including
Photoshop, Photoshop Elements, Paint Shop Pro, Photo-Paint, PhotoImpact and IrfanView. All versions support batch
processing and process RGB images with 8-bit and 16-bit/channel. The B/W Styler standalone application supports
JPEG, TIFF, PNG, PSD, Camera Raw and DNG image formats among others.

Overview

LightMachine corrects brightness, contrast, color and saturation in specific image areas independently from each other. It
basically consists of four different filters each split up into a simple mode suitable for beginners and a Pro mode with more
features for more flexibility. The Brightness/Contrast modes adjust brightness and contrast throughout the image which is
nice as a starting point. The Shadows/Highlights modes give you complete control over dark and bright image areas and
let you correct them completely independently from each other with the help of sophisticated masking options. The Virtual
Studio modes allow you to place an unlimited number of shadow and light spots as if you were placing studio lights in a
real photo studio. The intensity, size, ovality, angle, hardness and reflection properties of each spot can be adjusted
precisely. Finally, the Colors modes let you selectively correct image objects of a specific color by clicking on them.

Sophisticated Algorithms

LightMachine offers brightness, contrast and saturation correction algorithms that let you bring out more details without
making photos look unnatural. LightMachine's flexible shadow/highlight masking options let you quickly and easily adjust
specific image areas without affecting other regions. The Virtual Studio algorithms simulate light and shadows so
realistically that you will feel as though you are working in a photo studio rather than a two-dimensional photo.
LightMachine offers effective methods for dealing with problematic color shifts in lifted shadows and various different
saturation algorithms for avoiding color artifacts even at high saturation values.

Plenty of Tools

LightMachine uses a resizable dialog and its controls are logically organized in various tab sheets. Moving the mouse
over each control instantly displays a detailed explanation in the Help box, so you don't need to read the manual before
using LightMachine. Spilt Views let you display the original image side-by-side with the corrected version and the 17
different histograms can be useful as a guide. Complex corrections are made easy by LightMachine's Auto Mask feature,
which lets even beginners quickly create suitable masks. Four different modes for displaying the used mask help even
further. Removing color shifts in lifted shadows is a snap with LightMachine's one-click color picker. LightMachine's
Logged Settings feature can remember the settings used for any image and automatically loads them whenever they are
required again.

Why LightMachine is Different

LightMachine offers plenty of features for improving a much wider range of photos with better results. Other available
software often only give acceptable results for the common cases, but can't cope with more difficult cases. These



shadow/highlight tools usually produce contrast-burned or over-saturated results which cause an unnatural look. Unlike
LightMachine, they don't let you adjust shadows and highlights really independently, add artifacts along the
shadow/highlight borders or don't brighten shadows or darken highlights enough to make details clearly visible.

Other lighting tools usually produce only artistic effects and are not suitable for correcting photos. They don't give you
precise control over the lighting effects and offer no contrast options. They also affect the surrounding areas instead of
just focusing on the target area. They do not support a Reflection feature therefore you often can't avoid blown highlights
without decreasing the overall effect. LightMachine's Virtual Studio tool avoids these problems, because it was developed
for producing realistic light effects for correcting photos.

Other color-based correction tools don't allow to replace the color of a specific image area with any other imaginable color.
They are limited to a range of colors depending on the color that needs to be replaced. Most of these tools also don't let
you selectively adjust brightness and contrast and have no features for adjusting the border smoothness. LightMachine on
the other hand gives you complete control for color-based corrections.
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1.2 Compatibility

LightMachine works under Windows 10, 8, 7, Vista, XP (32-bit & 64-bit) and MacOS X (10.6 and higher). It supports
RGB 8bit and RGB 16bit color images/modes.

The Standalone Version runs on its own and does not need other applicatons. For details on its supported image
formats see here.

The Lightroom Version requires the following application to be installed:

Adobe Lightroom• 
ACDSee (Version 12 or higher)• 
ACDSee Pro (Version 3 or higher)• 
ACDSee Ultimate (Version 8 or higher)• 
Alienskin Exposure (Version X or higher)• 
Bibble Lite (Version 5 or higher)• 
Bibble Pro (Version 5 or higher)• 
Corel AfterShot Pro• 
CaptureOne (Version 10 and higher)• 
DxO Optics (Version 10 and higher)• 
OnOne Perfect PhotoSuite 9• 
ON1 Photo 10• 
ON1 Photo Raw (Version 2017 and higher)• 
Rawtherapee (Version 5 and higher)• 

The Plugin Version requires one of the following applications to be installed:

MacOS X:
64-bit:

Adobe Photoshop (Version CS5 or higher)◊ 
Adobe Photoshop Elements (Version 12 or higher)◊ 
Adobe Illustrator (Version CS6 or higher)◊ 
AlphaPlugins Launchbox◊ 
Computerinsel Photoline (Version 16.50 or higher)◊ 
LemkeSoft GraphicConverter (Version 8.2 or higher)◊ 
Serif Affinity Photo◊ 

32-bit:

Adobe Photoshop (Version CS3, CS4, CS5, CS5.5)◊ 
Adobe Photoshop Elements (Version 6 or higher)◊ 
Adobe Illustrator (Version CS2 to CS5)◊ 
Adobe Fireworks (Version CS3 or higher)◊ 
Computerinsel Photoline (Version 16.50 or higher)◊ 
LemkeSoft GraphicConverter (Version 8.2 or higher)

Other applications that support Photoshop plugins may also work

◊ 

Windows:
64-bit:

Adobe Photoshop (Version CS4 or higher)◊ 
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Adobe Photoshop Elements (Version 13 or higher)◊ 
Adobe Illustrator (Version CS6 or higher)◊ 
AlphaPlugins Launchbox◊ 
Computerinsel Photoline 64 (Version 16 or higher)◊ 
CorelDRAW (Version X6 or higher)◊ 
Corel Painter (Version 12.1 or higher)◊ 
Corel Paint Shop Pro (Version X6 or higher)◊ 
Corel Photo-Paint (Version X6 or higher)◊ 
Paint.NET (with the PSFilterPdn plugin) (Freeware: www.getpaint.net)◊ 
Serif PhotoPlus (Version X6 or higher)◊ 
Serif Affinity Photo◊ 

32-bit:

Adobe Photoshop (Version 3 or higher, Version CS1 or higher)◊ 
Adobe Photoshop Elements◊ 
Adobe PhotoDeluxe◊ 
Adobe After Effects (Version 4.1, 5.0 and 5.5, but not animatable)◊ 
Adobe Illustrator (Version 7 or higher)◊ 
Adobe ImageReady (Version 2 or higher)◊ 
Adobe PageMaker (Version 6.5 or higher)◊ 
ACDSystems Photo Canvas (Version 2 or higher)◊ 
ACDSystems Photo Editor (Version 3 or higher)◊ 
ACDSystems Canvas (Version X or higher)◊ 
albelli photo book creator (Freeware: www.albelli.co.uk)◊ 
Ambient Design ArtRage Studio Pro (Version 3 and higher)◊ 
Arcadia PhotoPerfect (Version 2.9 or higher)◊ 
ArcSoft PhotoStudio (Version 5.5 or higher)◊ 
Artweaver Plus (Version 3 or higher)◊ 
Aurora Borealis Mandala Painter (Version 3 or higher)◊ 
CADlink SignLab (Version 5 or higher)◊ 
CDH Image Explorer Pro (Version 4 or higher)◊ 
Computerinsel Photoline 32 (Version 5 or higher)◊ 
CorelDRAW (Version 9 or higher)◊ 
Corel Paint Shop Pro (Version 10 or higher)◊ 
Corel Photo-Paint (Version 9 or higher)◊ 
Corel Bryce (Version 4 or higher)◊ 
Corel Painter (Version 6 and higher, except Version 10 and 11)◊ 
Deneba Canvas (Version 6 or higher)◊ 
DigiFoto (Version 3.5 or higher) (Freeware: www.klausdoege.de)◊ 
DigiSoft ProMedia (Version 2 or higher)◊ 
DigiSoft ImagePro 2K1◊ 
Discreet Combustion (Version 2 or higher, but not animatable and preview is
bluish)

◊ 

Equilibrium DeBabelizer Pro (Version 4.5 or higher)◊ 
GIMP (Version 1.2.4 or higher with the PSPI plugin) (Preview doesn't work
correctly and may crash if you scroll it too often)

◊ 

Helicon Filter (Version 4.2 or higher)◊ 
Image Analyzer (with the 8bf Interface plugin) (Freeware:
meesoft.logicnet.dk)

◊ 

imageN (Freeware: www.pixoid.com)◊ 
IrfanView (Version 3.85 or higher, Freeware: www.irfanview.com)◊ 
Jasc Paint Shop Pro (Version 4.12 or higher)◊ 
KnowledgeAdventure HyperStudio (Version 4.2 or higher)◊ 
Logipole Konverter (Version 4 or higher)◊ 
Macromedia Freehand (Version 7 or higher)◊ 
Macromedia Fireworks (Version 2 or higher, but transparency isn't correctly
displayed in the preview)

◊ 

Magix Xtreme Photo Designer (Version 6 or higher, but applying the plugin to
a selection or object causes problems and sometimes random crashes occur,
Freeware: www.magix.com)

◊ 

Mediachance PhotoBrush◊ 
Megalux Ultimate Paint (Version 2 or higher)◊ 
Megalux Ultimate FX (Freeware)◊ 
Metacreations Painter (Version 6 or higher)◊ 
Microfrontier Digital Darkroom (Version 1.2 or higher)◊ 
Micrografx Picture Publisher (Version 8 or higher, but the preview zoom won't
work)

◊ 
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Microsoft Image Composer (Version 1.5 or higher, but dragging the preview
isn't possible)

◊ 

Microsoft PhotoDraw 2000◊ 
Microsoft Picture It! Digital Image Pro (Version 7 or higher, but a 100% zoom
may not work correctly and Cancel sometimes produces a crash)

◊ 

Newave Chaos Fx: Twilight'76 (Version 1.2 or higher)◊ 
New World Focus PhotoEditor (Version 4 or higher)◊ 
Paint.NET (with the PSFilterPdn plugin) (Freeware: www.getpaint.net)◊ 
19th Parallel Sagelight (Version 3 or higher)◊ 
Photobie Design Studio (Version 1.8 or higher) (Freeware:
www.photobie.com)

◊ 

Photo Filter Factory (Version 9 and higher)◊ 
Picmaster (Version 1.25 or higher)◊ 
Plugin Commander Pro (Version 1.5 or higher)◊ 
PluginMaster◊ 
PhotoFiltre Studio (Version 7 or higher)◊ 
PhotoFiltre (Version 6.5 or higher) (with the 8bf Filters plugin) (Freeware:
photofiltre.free.fr)

◊ 

RealWorld Paint.com (Version 2008.1 or higher) (Freeware:
www.rw-designer.com)

◊ 

QFX / QFX LE (Version 7 or higher)◊ 
Right Hemisphere Deep Paint◊ 
Satori PhotoXL (Version 2.29 or higher)◊ 
Serif PhotoPlus (Version 6 or higher)◊ 
Serif PhotoPlus Starter Edition (Version 2 or higher) (Freeware:
www.serif.com)

◊ 

SigmaPi Pixopedia 24 (Version 1.0.5 or higher)◊ 
SigmaPi NiGulp (Version 1.5 or higher) (Freeware: www.sigmapi-design.com)◊ 
Stoik PictureMan Pro (Version 5 or higher)◊ 
ThinkTank Ameri-Imager (Version 2 or higher)◊ 
Ulead Gif Animator (Version 4 or higher)◊ 
Ulead PhotoImpact (Version 4 or higher)◊ 
Ulead PhotoExpress (Version 6 or higher)◊ 
VCW Vicman's Photo Editor (Version 6.9 or higher, but preview dragging
causes crash) (Freeware: www.photo-editor.net)

◊ 

WebSuperGoo Achroma◊ 
Xara X◊ 
XnView (Version 1.70 or higher) (Freeware: www.xnview.com)◊ 
Zoner Photo Studio (Version 9 or higher)◊ 
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1.3 Supported Image Formats

The Standalone/Lightroom version supports the following image formats:

Saving

JPEG (8-bit/channel only)• 
TIFF (8-bit and 16-bit/channel)• 
PNG (8-bit and 16-bit/channel)• 
PSD (8-bit and 16-bit/channel)• 

Opening

BMP (8-bit/channel only)• 
Camera RAW including DNG (16-bit/channel)• 
JPEG (8-bit/channel only)• 
TIFF (8-bit and 16-bit/channel)• 
PNG (8-bit and 16-bit/channel)• 
PSD (8-bit and 16-bit/channel)• 
WMF, EMF, AMF (8-bit/channel only)• 
PCD (8-bit/channel only)• 
PCX (8-bit/channel only)• 
TGA (8-bit/channel only)• 

Camera RAW files of the following 1040+ camera types are supported (If your camera is not mentioned here, it may still
be supported. Please see yourself, e.g. with the demo version, if your raw files are opened):

AgfaPhoto DC-833m
Alcatel 5035D
Alcatel 5235D
Apple QuickTake 100
Apple QuickTake 150
Apple QuickTake 200
Apple iPad Pro 9.7" (DNG format)
Apple iPhone 6s (DNG format)
Apple iPhone 6s Plus (DNG format)
Apple iPhone 7 (DNG format)
Apple iPhone 7 Plus (DNG format)
Apple iPhone SE (DNG format)
AVT F-080C
AVT F-145C
AVT F-201C
AVT F-510C
AVT F-810C
Baumer TXG14
Blackmagic Cinema Camera (DNG format)
BlackMagic Micro Cinema Camera (DNG format)
BlackMagic Pocket Cinema Camera (DNG format)
BlackMagic Production Camera 4k (DNG format)
Blackmagic URSA (DNG format)
Blackmagic URSA 4K (DNG format)
BlackMagic URSA Mini (DNG format)
Canon EOS-1D
Canon EOS-1D C
Canon EOS-1DS
Canon EOS-1D X
Canon EOS-1D X Mark II
Canon EOS-1D Mark II
Canon EOS-1D Mark II N
Canon EOS-1D Mark III
Canon EOS-1D Mark IV
Canon EOS-1Ds Mark II
Canon EOS-1Ds Mark III
Canon EOS 5D
Canon EOS 5D Mark II
Canon EOS 5D Mark III
Canon EOS 5D Mark IV
Canon EOS 5DS

HUAWEI P10 Plus (VKY-L09) (DNG
format)
Ikonoskop A-Cam dII Panchromatic
Ikonoskop A-Cam dII
Imacon Ixpress 16-megapixel
Imacon Ixpress 22-megapixel
Imacon Ixpress 39-megapixel
ISG 2020x1520
Kinefinity KineMINI
Kinefinity KineRAW Mini
Kinefinity KineRAW S35
Kodak C330
Kodak C603
Kodak DC20
Kodak DC25
Kodak DC40
Kodak DC50
Kodak DC120
Kodak DCS200
Kodak DCS315C
Kodak DCS330C
Kodak DCS420
Kodak DCS460
Kodak DCS460A
Kodak DCS460D
Kodak DCS520C
Kodak DCS560C
Kodak DCS620C
Kodak DCS620X
Kodak DCS660C
Kodak DCS660M
Kodak DCS720X
Kodak DCS760C
Kodak DCS760M
Kodak DCS Pro 14n
Kodak DCS Pro 14nx
Kodak DCS Pro SLR/c
Kodak DCS Pro SLR/n
Kodak Ektra
Kodak EOS DCS1
Kodak EOS DCS 3B

Panasonic FZ30
Panasonic FZ35
Panasonic FZ38
Panasonic FZ4
Panasonic FZ40
Panasonic FZ42
Panasonic FZ45
Panasonic FZ50
Panasonic FZ7
Panasonic FZ70
Panasonic FZ72
Panasonic FZ8
Panasonic FZ80
Panasonic FZ82
Panasonic FZ85
Panasonic FZ100
Panasonic FZ150
Panasonic FZ200
Panasonic FZ270
Panasonic FZ272
Panasonic FZ300
Panasonic FZ330
Panasonic FZ1000
Panasonic FZ1000 X
Panasonic FZ2000
Panasonic FZ2500
Panasonic FZH1
Panasonic G1
Panasonic G2
Panasonic G3
Panasonic G5
Panasonic G6
Panasonic G7
Panasonic G70
Panasonic G8
Panasonic G80
Panasonic G81
Panasonic G85
Panasonic G10
Panasonic GF1
Panasonic GF2
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Canon EOS 5DS R
Canon EOS 6D
Canon EOS 6D Mark II
Canon EOS 7D
Canon EOS 7D Mark II
Canon EOS 10D
Canon EOS 20D
Canon EOS 20Da
Canon EOS 30D
Canon EOS 40D
Canon EOS 50D
Canon EOS 60D
Canon EOS 60Da
Canon EOS 70D
Canon EOS 77D
Canon EOS 80D
Canon EOS 100D / Digital Rebel SL1 / Kiss Digital X7
Canon EOS 200D / Digital Rebel SL2 / Kiss Digital X9
Canon EOS 300D / Digital Rebel / Kiss Digital
Canon EOS 350D / Digital Rebel XT / Kiss Digital N
Canon EOS 400D / Digital Rebel XTi / Kiss Digital X
Canon EOS 450D / Digital Rebel XSi / Kiss Digital X2
Canon EOS 500D / Digital Rebel T1i / Kiss Digital X3
Canon EOS 550D / Digital Rebel T2i / Kiss Digital X4
Canon EOS 600D / Digital Rebel T3i / Kiss Digital X5
Canon EOS 650D / Digital Rebel T4i / Kiss Digital X6i
Canon EOS 700D / Digital Rebel T5i / Kiss Digital X7i
Canon EOS 750D / Digital Rebel T6i / Kiss Digital X8i
Canon EOS 760D / Digital Rebel T6S / Kiss Digital 8000D
Canon EOS 800D / Digital Rebel T7i / Kiss Digital X9i
Canon EOS 1000D / Digital Rebel XS / Kiss Digital F
Canon EOS 1100D / Digital Rebel T3 / Kiss Digital X50
Canon EOS 1200D / Digital Rebel T5 / Kiss X70
Canon EOS 1300D / Digital Rebel T6 / Kiss X80
Canon EOS C500
Canon EOS D30
Canon EOS D60
Canon EOS D2000C
Canon EOS M
Canon EOS M2
Canon EOS M3
Canon EOS M5
Canon EOS M6
Canon EOS M10
Canon Ixus 160 (CHDK hack)
Canon Ixus 900 Ti (CHDK hack)
Canon PowerShot 600
Canon PowerShot A5
Canon PowerShot A5 Zoom
Canon PowerShot A50
Canon PowerShot A410 (CHDK hack)
Canon PowerShot A460 (CHDK hack)
Canon PowerShot A470 (CHDK hack)
Canon PowerShot A530 (CHDK hack)
Canon PowerShot A540 (CHDK hack)
Canon PowerShot A550 (CHDK hack)
Canon PowerShot A570 (CHDK hack)
Canon PowerShot A590 (CHDK hack)
Canon PowerShot A610 (CHDK hack)
Canon PowerShot A620 (CHDK hack)
Canon PowerShot A630 (CHDK hack)
Canon PowerShot A640 (CHDK hack)
Canon PowerShot A650 (CHDK hack)
Canon PowerShot A710 IS (CHDK hack)
Canon PowerShot A720 IS (CHDK hack)
Canon PowerShot A3200 IS (CHDK hack)
Canon PowerShot A3300 IS (CHDK hack)
Canon PowerShot D10
Canon PowerShot Pro70
Canon PowerShot Pro90 IS
Canon PowerShot Pro1
Canon PowerShot G1
Canon PowerShot G1 X
Canon PowerShot G1 X Mark II
Canon PowerShot G2
Canon PowerShot G3
Canon PowerShot G3 X
Canon PowerShot G5
Canon PowerShot G5 X
Canon PowerShot G6
Canon PowerShot G7 (CHDK hack)
Canon PowerShot G7 X

Kodak NC2000F
Kodak KAI-0340
Kodak NC2000F
Kodak P850
Kodak P880
Kodak ProBack
Kodak PB645C
Kodak PB645H
Kodak PB645M
Kodak S-1
Kodak Z980
Kodak Z981
Kodak Z990
Kodak Z1015
Konica KD-400Z
Konica KD-510Z
Leaf AFi 5
Leaf AFi 6
Leaf AFi 7
Leaf AFi-II 6
Leaf AFi-II 7
Leaf AFi-II 10
Leaf AFi-II 10R
Leaf AFi-II 12
Leaf Aptus 17
Leaf Aptus 22
Leaf Aptus 54S
Leaf Aptus 65
Leaf Aptus 65S
Leaf Aptus 75
Leaf Aptus 75S
Leaf Aptus-II 5
Leaf Aptus-II 6
Leaf Aptus-II 7
Leaf Aptus-II 8
Leaf Aptus-II 10
Leaf Aptus-II 10R
Leaf Aptus-II 12
Leaf Aptus-II 12R
Leaf Cantare
Leaf Cantare XY
Leaf CatchLight
Leaf CMost
Leaf DCB2
Leaf Valeo 6
Leaf Valeo 11
Leaf Valeo 17
Leaf Valeo 17wi
Leaf Valeo 22
Leaf Valeo 22wi
Leaf Volare
Lenovo A820
Leica C (Typ 112)
Leica Digilux 2
Leica Digilux 3
Leica D-LUX2
Leica D-LUX3
Leica D-LUX4
Leica D-LUX5
Leica D-LUX6
Leica D-Lux y
Leica D-LUX (Typ 109)
Leica Digital-Modul-R (DNG format)
Leica M Monochrom (DNG format)
Leica M (Typ 240) (DNG format)
Leica M Monochrom (Typ 246) (DNG
format)
Leica M (Typ 262) (DNG format)
Leica M8 (DNG format)
Leica M8.2 (DNG format)
Leica M9 (DNG format)
Leica M10 (DNG format)
Leica M-D (Typ 262) (DNG format)
Leica M-E (DNG format)
Leica M-P (DNG format)
Leica Q (DNG format)
Leica Q (Typ 1) (DNG format)
Leica Q (Typ 116) (DNG format)
Leica R8 (DNG format)
Leica S (DNG format)
Leica S (Typ 007) (DNG format)
Leica S2 (DNG format)

Panasonic GF3
Panasonic GF5
Panasonic GF6
Panasonic GF7
Panasonic GF8
Panasonic GF9
Panasonic GH1
Panasonic GH2
Panasonic GH3
Panasonic GH4
Panasonic GH5
Panasonic GM1
Panasonic GM1s
Panasonic GM5
Panasonic GX1
Panasonic GX7
Panasonic GX7 Mark II
Panasonic GX8
Panasonic GX80
Panasonic GX85
Panasonic GX800
Panasonic GX850
Panasonic L1
Panasonic L10
Panasonic LC1
Panasonic LF1
Panasonic LX1
Panasonic LX2
Panasonic LX3
Panasonic LX5
Panasonic LX7
Panasonic LX9
Panasonic LX10
Panasonic LX15
Panasonic LX100
Panasonic TX1
Panasonic TZ60
Panasonic TZ61
Panasonic TZ70
Panasonic TZ71
Panasonic TZ80
Panasonic TZ81
Panasonic TZ82
Panasonic TZ85
Panasonic TZ90
Panasonic TZ91
Panasonic TZ92
Panasonic TZ93
Panasonic TZ100
Panasonic TZ101
Panasonic TZ110
Panasonic ZS40
Panasonic ZS50
Panasonic ZS60
Panasonic ZS100
Panasonic ZS110
PARROT Bebop 2 (DNG format)
PARROT Bebop Drone (DNG
format)
PARROT Bebop 2 (DNG format)
PARROT Bebop Drone (DNG
format)
Pentax 645D
Pentax 645Z
Pentax *ist D
Pentax *ist DL
Pentax *ist DL2
Pentax *ist DS
Pentax *ist DS2
Pentax GR
Pentax K10D
Pentax K20D
Pentax K100D
Pentax K100D Super
Pentax K110D
Pentax K200D
Pentax K2000/K-m
Pentax K-01 (DNG format)
Pentax K-1 (DNG format)
Pentax K-3
Pentax K-3 II
Pentax K-30 (DNG format)
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Canon PowerShot G7 X Mark II
Canon PowerShot G9
Canon PowerShot G9 X
Canon PowerShot G9 X Mark II
Canon PowerShot G10
Canon PowerShot G11
Canon PowerShot G12
Canon PowerShot G15
Canon PowerShot G16
Canon PowerShot S2 IS (CHDK hack)
Canon PowerShot S3 IS (CHDK hack)
Canon PowerShot S5 IS (CHDK hack)
Canon PowerShot SD300 (CHDK hack)
Canon PowerShot SD450 (CHDK hack)
Canon PowerShot SD750 (CHDK hack)
Canon PowerShot SD950 (CHDK hack)
Canon PowerShot S30
Canon PowerShot S40
Canon PowerShot S45
Canon PowerShot S50
Canon PowerShot S60
Canon PowerShot S70
Canon PowerShot S90
Canon PowerShot S95
Canon PowerShot S100
Canon PowerShot S110
Canon PowerShot S120
Canon PowerShot SX1 IS (CHDK hack)
Canon PowerShot SX10 IS (CHDK hack)
Canon PowerShot SX20 IS (CHDK hack)
Canon PowerShot SX30 IS (CHDK hack)
Canon PowerShot SX50 HS (CHDK hack)
Canon PowerShot SX100 IS (CHDK hack)
Canon PowerShot SX110 IS (CHDK hack)
Canon PowerShot SX120 IS (CHDK hack)
Canon PowerShot SX130 IS (DNG format)
Canon PowerShot SX220 HS (CHDK hack)
Canon PowerShot SX230 HS (CHDK hack)
Canon PowerShot SX510 HS (DNG format)
Canon PowerShot SX60 HS
Casio EX-F1 (DNG format)
Casio EX-FC300S (DNG format)
Casio EX-FC400S (DNG format)
Casio EX-FH20 (DNG format)
Casio EX-FH25 (DNG format)
Casio EX-FH100 (DNG format)
Casio EX-10 (DNG format)
Casio EX-100 (DNG format)
Casio EX-100F (DNG format)
Casio EX-100PRO (DNG format)
Casio EX-ZR700 (DNG format)
Casio EX-ZR710 (DNG format)
Casio EX-ZR750 (DNG format)
Casio EX-ZR800 (DNG format)
Casio EX-ZR850 (DNG format)
Casio EX-ZR1000 (DNG format)
Casio EX-ZR1100 (DNG format)
Casio EX-ZR1200 (DNG format)
Casio EX-ZR1300 (DNG format)
Casio EX-ZR1500 (DNG format)
Casio EX-ZR3000 (DNG format)
Casio EX-ZR3100 (DNG format)
Casio EX-ZR3500 (DNG format)
Casio EX-ZR3600 (DNG format)
Casio EX-ZR4000 (DNG format)
Casio EX-ZR5000 (DNG format)
Casio EX-S20
Casio EX-S100
Casio EX-Z4
Casio EX-Z50
Casio EX-Z500
Casio EX-Z55
Casio EX-Z60
Casio EX-Z75
Casio EX-Z750
Casio EX-Z8
Casio EX-Z850
Casio EX-Z1050
Casio EX-Z1080
Casio EX-ZR100
Casio Exlim Pro 505
Casio Exlim Pro 600

Leica SL (Typ 601) (DNG format)
Leica T (Typ 701) (DNG format)
Leica TL (DNG format)
Leica TL2 (DNG format)
Leica V-LUX1
Leica V-LUX2
Leica V-LUX3
Leica V-LUX4
Leica V-LUX (Typ 114)
Leica X VARIO (Typ 107) (DNG format)
Leica X (Typ 113) (DNG format)
Leica X-E (Typ 102) (DNG format)
Leica X1
Leica X2
Leica X-U (Typ 113) (DNG format)
LG G3 (LG-D855) (DNG format)
LG G4 (DNG format)
LG Nexus 5 (DNG format)
LG Nexus 5X (DNG format)
LG V20 (DNG format)
Logitech Fotoman Pixtura
Mamiya ZD
Matrix 4608x3288
Meizy MX4
Micron 2010
Microsoft Lumia 950 (DNG format)
Minolta RD175
Minolta DiMAGE 5
Minolta DiMAGE 7
Minolta DiMAGE 7i
Minolta DiMAGE 7Hi
Minolta DiMAGE A1
Minolta DiMAGE A2
Minolta DiMAGE A200
Minolta DiMAGE G400
Minolta DiMAGE G500
Minolta DiMAGE G530
Minolta DiMAGE G600
Minolta DiMAGE Z2
Minolta Alpha/Dynax/Maxxum 5D
Minolta Alpha/Dynax/Maxxum 7D
Motorola Nexus 6 (DNG format)
Motorola PIXL
Nikon Coolscan
Nikon Coolpix A
Nikon Coolpix B700
Nikon Coolpix P330
Nikon Coolpix P340
Nikon Coolpix P6000
Nikon Coolpix P7000
Nikon Coolpix P7100
Nikon Coolpix P7700
Nikon Coolpix P7800
Nikon Coolpix S6 (DIAG RAW hack)
Nikon D1
Nikon D1H
Nikon D1X
Nikon D2H
Nikon D2Hs
Nikon D2X
Nikon D2Xs
Nikon D3
Nikon D3s
Nikon D3X
Nikon D4
Nikon D40
Nikon D4s
Nikon D40X
Nikon D5
Nikon D50
Nikon D500
Nikon D60
Nikon D70
Nikon D70s
Nikon D80
Nikon D90
Nikon D100
Nikon D200
Nikon D300
Nikon D300s
Nikon D600
Nikon D610

Pentax K-5
Pentax K-5 II
Pentax K-5 II s
Pentax K-50 (DNG format)
Pentax K-500 (DNG format)
Pentax K-7
Pentax K-70 (DNG format)
Pentax KP (DNG-Format)
Pentax K-r
Pentax K-S1
Pentax K-S2
Pentax K-x
Pentax MX-1 (DNG format)
Pentax Q (DNG format)
Pentax Q7 (DNG format)
Pentax Q10 (DNG format)
Pentax QS-1 (DNG format)
Pentax Optio S
Pentax Optio S4
Pentax Optio 33WR
Pentax Optio 750Z
Phase One Achromatic
Phase One Achromatic+
Phase One LightPhase
Phase One H 10
Phase One H 20
Phase One H 25
Phase One IQ3 50MP
Phase One IQ3 60MP
Phase One IQ3 80MP
Phase One IQ3 100MP
Phase One IQ140
Phase One IQ150
Phase One IQ160
Phase One IQ180
Phase One IQ180 IR
Phase One IQ250
Phase One IQ260
Phase One IQ280
Phase One P 20
Phase One P 20+
Phase One P 21
Phase One P 21 +
Phase One P 25
Phase One P 25+
Phase One P 30
Phase One P 30+
Phase One P 40+
Phase One P 45
Phase One P 45+
Phase One P 65
Phase One P 65+
Photron BC2-HD
Pixelink A782
Polaroid x530
Ricoh GR (DNG format)
Ricoh GR II (DNG format)
Ricoh GR Digital (DNG format)
Ricoh GR Digital II (DNG format)
Ricoh GR Digital III (DNG format)
Ricoh GR Digital IV (DNG format)
Ricoh GX100 (DNG format)
Ricoh GX200 (DNG format)
Ricoh GXR, S10 24-72mm F2.5-4.4
VC (DNG format)
Ricoh GXR, GR A12 50mm F2.5
MACRO
Ricoh GXR, GR LENS A12 28mm
F2.5
Ricoh GXR MOUNT A12
Ricoh GXR MOUNT A16 24-85mm
F3.5-5
Ricoh GXR, GXR P10 (DNG format)
Rollei d530flex
RoverShot 3320af
Samsung EX1
Samsung EX2F
Samsung Galaxy NX (EK-GN120)
Samsung Galaxy S3
Samsung Galaxy S7 (DNG format)
Samsung Galaxy S7 Edge (DNG
format)
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Casio Exlim Pro 700
Casio QV-2000UX
Casio QV-3000EX
Casio QV-3500EX
Casio QV-4000
Casio QV-5700
Casio QV-R41
Casio QV-R51
Casio QV-R61
Contax N Digital
Creative PC-CAM 600
Digital Bolex D16
Digital Bolex D16M
DJI 4384x3288
DJI X5 (FC550) (DNG Format)
DJI Inspire 2 (M43RAW)
DJI Mavi (FC220)
DJI Phantom 4 (FC330)
DJI Phantom 4 Pro (FC6310)
DxO One
Epson R-D1
Epson R-D1s
Epson R-D1x
Foculus 531C
Fujifilm E505
Fujifilm E550
Fujifilm E900
Fujifilm F505EXR
Fujifilm F550EXR
Fujifilm F600EXR
Fujifilm F605EXR
Fujifilm F700
Fujifilm F710
Fujifilm F770EXR
Fujifilm F775EXR
Fujifilm F800
Fujifilm F800EXR
Fujifilm F810
Fujifilm F900EXR
Fujifilm FinePix S1
Fujifilm GFX 50S
Fujifilm HS10
Fujifilm HS11
Fujifilm HS20EXR
Fujifilm HS22EXR
Fujifilm HS30EXR
Fujifilm HS33EXR
Fujifilm HS35EXR
Fujifilm HS50EXR
Fujifilm IS-1
Fujifilm S2Pro
Fujifilm S3Pro
Fujifilm S5Pro
Fujifilm S20
Fujifilm S20Pro
Fujifilm S205EXR
Fujifilm S100FS
Fujifilm S5000
Fujifilm S5100
Fujifilm S5500
Fujifilm S5200
Fujifilm S5600
Fujifilm S6000fd
Fujifilm S7000
Fujifilm S9000
Fujifilm S9100
Fujifilm S9500
Fujifilm S9600
Fujifilm S200EXR
Fujifilm SL1000
Fujifilm X10
Fujifilm X20
Fujifilm X30
Fujifilm X70
Fujifilm X100
Fujifilm X100F
Fujifilm X100S
Fujifilm X100T
Fujifilm X-A1
Fujifilm X-A2
Fujifilm X-A3
Fujifilm X-A10

Nikon D700
Nikon D750
Nikon D3000
Nikon D3100
Nikon D3200
Nikon D3300
Nikon D3400
Nikon D5000
Nikon D5100
Nikon D5200
Nikon D5300
Nikon D5500
Nikon D5600
Nikon D7000
Nikon D7100
Nikon D7200
Nikon D7500
Nikon D800
Nikon D800E
Nikon D810
Nikon D810A
Nikon D850
Nikon Df
Nikon 1 AW1
Nikon 1 J1
Nikon 1 J2
Nikon 1 J3
Nikon 1 J4
Nikon 1 J5
Nikon 1 S1
Nikon 1 S2
Nikon 1 V1
Nikon 1 V2
Nikon 1 V3
Nikon E700 (DIAG RAW hack)
Nikon E800 (DIAG RAW hack)
Nikon E880 (DIAG RAW hack)
Nikon E900 (DIAG RAW hack)
Nikon E950 (DIAG RAW hack)
Nikon E990 (DIAG RAW hack)
Nikon E995 (DIAG RAW hack)
Nikon E2100 (DIAG RAW hack)
Nikon E2500 (DIAG RAW hack)
Nikon E3200 (DIAG RAW hack)
Nikon E3700 (DIAG RAW hack)
Nikon E4300 (DIAG RAW hack)
Nikon E4500 (DIAG RAW hack)
Nikon E5000
Nikon E5400
Nikon E5700
Nikon E8400
Nikon E8700
Nikon E8800
Nokia 1200x1600
Nokia Lumia 950 XL (DNG Format)
Nokia Lumia 1020 (DNG Format)
Nokia Lumia 1520 (DNG format)
Nokia N9
Nokia N95
Nokia X2
Olympus AIR A01
Olympus C3030Z
Olympus C5050Z
Olympus C5060WZ
Olympus C5060Z
Olympus C7070WZ
Olympus C70Z
Olympus C7000Z
Olympus C740UZ
Olympus C770UZ
Olympus C8080WZ
Olympus X200
Olympus D560Z
Olympus C350Z
Olympus E-1
Olympus E-3
Olympus E-5
Olympus E-10
Olympus E-20
Olympus E-30
Olympus E-300
Olympus E-330

Samsung Galaxy S8 (DNG format)
Samsung Galaxy S8+ (DNG format)
Samsung Galaxy Nexus
Samsung GX-1S
Samsung GX-1L
Samsung GX10 (DNG format)
Samsung GX20 (DNG format)
Samsung NX mini
Samsung NX U
Samsung NX1
Samsung NX5
Samsung NX10
Samsung NX11
Samsung NX20
Samsung NX30
Samsung NX100
Samsung NX200
Samsung NX210
Samsung NX300
Samsung NX300M
Samsung NX500
Samsung NX1000
Samsung NX1100
Samsung NX2000
Samsung NX3000
Samsung NX3300
Samsung Pro 815 (DNG format)
Samsung S85 (hacked)
Samsung S850 (hacked)
Samsung TL350
Samsung TL500
Samsung WB550
Samsung WB2000
Sarnoff 4096x5440
Seitz Roundshot D3
Seitz Roundshot D2X
Seitz Roundshot D2Xs
Sinar 3072x2048
Sinar 4080x4080
Sinar 4080x5440
Sinar eMotion 22
Sinar eMotion 54
Sinar eSpirit 65
Sinar eMotion 75
Sinar eVolution 75
Sinar Sinarback 54
SMaL Ultra-Pocket 3
SMaL Ultra-Pocket 4
SMaL Ultra-Pocket 5
Sony A7 (ILCE-7)
Sony A7 II (ILCE-7 II)
Sony A7R (ILCE-7R)
Sony A7R II (ILCE-7R II)
Sony A7S (ILCE-7S)
Sony A7S II (ILCE-7S II)
Sony A9 (ILCE-9)
Sony A33 (SLT-A33)
Sony A35 (SLT-A35)
Sony A37 (SLT-A37)
Sony A55V (SLT-A55V)
Sony A57 (SLT-A57)
Sony A58 (SLT-A58)
Sony A65 (SLT-A65)
Sony A65V(SLT-A65V)
Sony A68 (SLT-A68)
Sony A68 (ILCA-68)
Sony A77 (SLT-A77)
Sony A77 II (ILCA-77M2)
Sony A99 (SLT-A99V)
Sony A99 II (ILCA-99 II)
Sony A100 (DSLR-A100)
Sony A200 (DSLR-A200)
Sony A230 (DSLR-A230)
Sony A290 (DSLR-A290)
Sony A300 (DSLR-A300)
Sony A330 (DSLR A330)
Sony A350 (DSLR-A350)
Sony A380 (DSLR-A380)
Sony A390 (DSLR-A390)
Sony A450 (DSLR-A450)
Sony A500 (DSLR-A500)
Sony A550 (DSLR-A550)

LightMachine Manual 9



Fujifilm X-E1
Fujifilm X-E2
Fujifilm X-E2S
Fujifilm X-E3
Fujifilm XF1
Fujifilm X-M1
Fujifilm X-Pro1
Fujifilm X-Pro2
Fujifilm X-S1
Fujifilm X-T1
Fujifilm X-T1 IR
Fujifilm X-T2
Fujifilm X-T10
Fujifilm X-T20
Fujifilm XQ1
Fujifilm XQ2
Gione E7
GITUP GIT2
GITUP GIT2P
Google Pixel XL
Hasselblad CF-22
Hasselblad CF-22MS
Hasselblad CF-31
Hasselblad CF-39
Hasselblad CF-39MS
Hasselblad CF-132
Hasselblad CFH
Hasselblad CFH-22
Hasselblad CFH-39
Hasselblad CFV
Hasselblad CFV-2
Hasselblad CFV-50
Hasselblad CFV-50c
Hasselblad H2D (DNG format)
Hasselblad H2D-22 (DNG format)
Hasselblad H2D-39 (DNG format)
Hasselblad H3D-22
Hasselblad H3D-31
Hasselblad H3D-39
Hasselblad H3D-50
Hasselblad H3DII-22
Hasselblad H3DII-31
Hasselblad H3DII-39
Hasselblad H3DII-39MS
Hasselblad H3DII-50
Hasselblad H3DII-50MS
Hasselblad H4D-31
Hasselblad H4D-40
Hasselblad H4D-50
Hasselblad H4D-60
Hasselblad H5D-40
Hasselblad H5D-50
Hasselblad H5D-50c
Hasselblad H5D-50cMS
Hasselblad H5D-200cMS
Hasselblad HV
Hasselblad Lusso
Hasselblad Lunar
Hasselblad True Zoom
Hasselblad Stellar
Hasselblad Stellar II
Hasselblad V96C
Hasselblad X1D
HTC 10 (DNG format)
HTC One (A9) (DNG format)
HTC One (M9) (DNG format)
HTC MyTouch 4G (DNG format)
HTC UltraPixel (DNG format)
Huawei Mate 9 (DNG format)
Huawei P9 (DNG format)

Olympus E-400
Olympus E-410
Olympus E-420
Olympus E-450
Olympus E-500
Olympus E-510
Olympus E-520
Olympus E-600
Olympus E-620
Olympus E-M1
Olympus E-M1 Mark II
Olympus E-M10
Olympus E-M10 Mark II
Olympus E-M10 Mark III
Olympus E-M5
Olympus E-M5 Mark II
Olympus E-P1
Olympus E-P2
Olympus E-P3
Olympus E-P5
Olympus E-PL1
Olympus E-PL1s
Olympus E-PL2
Olympus E-PL3
Olympus E-PL5
Olympus E-PL6
Olympus E-PL7
Olympus E-PL8
Olympus E-PM1
Olympus E-PM2
Olympus PEN-F
Olympus SH-2
Olympus SH-3
Olympus SP310
Olympus SP320
Olympus SP350
Olympus SP500UZ
Olympus SP510UZ
Olympus SP550UZ
Olympus SP560UZ
Olympus SP565UZ
Olympus SP570UZ
Olympus Stylus 1
Olympus Stylus 1s
Olympus TG-4
Olympus TG-5
Olympus XZ-1
Olympus XZ-2
Olympus XZ-10
OmniVision 4688
OmniVision 13860
OmniVision OV5647 (Raspberry Pi)
OmniVision OV5648
OmniVision OV8850
OnePlus One A0001 (DNG format)
OnePlus 3 (DNG format)
Panasonic CM1
Panasonic CM10
Panasonic FX150
Panasonic FZ18
Panasonic FZ28

Sony A560 (DSLR-A560)
Sony A580 (DSLR-A580)
Sony A700 (DSLR-A700)
Sony A850 (DSLR-A850)
Sony A900 (DSLR-A900)
Sony A3000 (ILCE-3000)
Sony A3500 (ILCE-3500)
Sony A5000 (ILCE-5000)
Sony A5100 (ILCE-5100)
Sony A6000 (ILCE-6000)
Sony A6300 (ILCE-6300)
Sony A6500 (ILCE-6500)
Sony F828 (DSC-F828)
Sony IMX135-mipi 13mp
Sony IMX135-QCOM
Sony IMX072-mipi
Sony IMX214
Sony IMX219
Sony IMX230
Sony IMX298-mipi 16mp
Sony IMX219-mipi 8mp
Sony NEX-3
Sony NEX-3N
Sony NEX-5
Sony NEX-5N
Sony NEX-5R
Sony NEX-5T
Sony NEX-6
Sony NEX-7
Sony NEX-C3
Sony NEX-F3
Sony NEX-VG20
Sony NEX-VG30
Sony NEX-VG900
Sony R1 (DSC-R1)
Sony RX1 (DSC-RX1)
Sony RX1R (DSC-RX1R)
Sony RX1R II (DSC-RX1RM2)
Sony RX10 (DSC-RX10)
Sony RX10 II (DSC-RX10M2)
Sony RX10 III (DSC-RX10M3)
Sony RX100 (DSC-RX100)
Sony RX100 II (DSC-RX100M2)
Sony RX100 III (DSC-RX100M3)
Sony RX100 IV (DSC-RX100M4)
Sony RX100 V (DSC-RX100M5)
Sony QX1 (ILCE-QX1)
Sony V3 (DSC-V3)
Sony XCD-SX910CR
Sony Xperia L (DNG Format)
STV680 VGA
Xiaomi MI3 (DNG Format)
Xiaomi RedMi Note3 Pro (DNG
Format)
Yi Xiaoyi M1 (DNG Format)
Yuneec CGO3 (DNG format)
Yuneec CGO3P (DNG format)
Yuneec CGO4
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1.4 Installation

1.4.1 Installing the Plugin Version under Windows

Method 1: Using Plugin Installer

After running the installer and choosing your installation language keep clicking the Next button. At some point during the
installation process you will arrive at the "Choose Destination Location" dialog. On it you may enter the installation
location for the LightMachine plugin. But we recommend that you keep the suggested installation path as you can later
use the Plugin Installer tool to conveniently install the plugin.

At the end of the installation process the Plugin Installer dialog will be shown with a list of compatible applications, which
are installed on your computer. The application at the top of the list is always activated by default. If you want to install
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LightMachine into other applications, you should activate them, too. Then press the Install button to copy the
LightMachine plugin into the plugin folder of the selected application(s). Finally leave Plugin Installer with the Exit button.

You can run Plugin Installer again at any time from Start > All Programs > The Plugin Site to add LightMachine to a new
or previously installed compatible application.

Note: If your application is not listed in Plugin Installer or if Plugin Installer terminates telling you that it didn't manage to
find an application, we suggest to try Method 2 below.

Method 2: Choosing a different installation folder and ignoring Plugin Installer

Method 1 is usually the most convenient way of installing LightMachine. If you keep your plugins in a folder outside your
application's plugin folder, prefer to enter the installation folder in your application's preferences dialog or use an
application that is not recognized by Plugin Installer, please do the following: On the "Choose Destination Location" dialog
during installation select your preferred plugin folder. When Plugin Installer opens next, ignore it by closing it with the Exit
button.

1.4.2 Installing the Plugin Version under MacOS X

After double clicking the downloaded .dmg file, click the Agree button to confirm the license agreement. To install the
plugin(s) to all supported applications on your computer double click the Install icon. This will install the plugin(s) to Affinity
Photo, GraphicConverter and PhotoLine as well as all available versions of Photoshop and Photoshop Elements. If you
want to install to a certain Photoshop or Photoshop Elements version only, drag and drop the PhotoWiz folder icon onto
the appropriate icon on the right inside the .dmg window.

1.4.3 Installing the Standalone/Lightroom Version under Windows

If you have Lightroom (Version 2 or higher) installed, the installer automatically adds a LightMachine menu item to the
Photo > Edit In menu of all Lightroom installations. If LightMachine does not appear in Lightroom, please deactivate the
following check box: Edit > Preferences > Presets > Store presets with catalog. If this option is activated, Lightroom uses
different external editors for each catalog. To support this option the installer would need to search all your hard drives for
Lightroom catalogs and install LightMachine into each catalog, which would be quite time consuming and would probably
not work for archived catalogs. If you nevertheless want to keep this option activated, we recommend that you either add
LightMachine manually as described in the next paragraph or manually copy the LightMachine .lrtemplate file into the
External Editor Presets sub folder of your catalogs.

The External Editor Installer also installs the Lightroom version of LightMachine into Exposure X2 (and higher), Bibble 5,
After Shot Pro, ACDSee, ACDSee Pro and ACDSee Ultimate if they are available. For using the Lightroom version of
LightMachine in Capture One, DxO Optics, ON1 and Rawtherapee you have to choose the LightMachineLR.exe file,
which is located in the installation folder, from the external editor feature of the appropriate application itself. See the
Product Launch page for more details.
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1.4.4 Installation in Lightroom 1.x under Windows

While the installation automatically adds LightMachine to Version 2 and higher of Lightroom, Version 1 of Lightroom
requires manual installation as described below. Please note that Lightroom 1.x only supports one external editor, which
means that you have to repeat the following step every time you want to use another external editor, such as the other
PhotoWiz editors.

In Lightroom 1.x choose Edit > Preferences, then click on the External Editing tab sheet. in the Additional External Editor
group set the File Format combo box to "TIFF", Color Space to "sRGB", Bit Depth to "16bits/component" and
Compression to "None". Press the Choose button to navigate to the LightMachine installation folder. Select the file
LightMachineLR.exe, then press OK. Now you will be able to access LightMachine from the menu under "Photo > Edit in
LightMachineLR.exe" or by right clicking on an image and selecting "Edit in LightMachineLR.exe" from the context menu.
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1.5  General Usage

1.5.1 Running the Plugin

Run your image processing application of choice, e.g. Photoshop, and open an image file. To launch LightMachine please
open the menu that leads to the plugin filters (e.g. the Filter menu in Photoshop and Elements, the Image -> Plug-ins in
Paint Shop Pro or the Effects menu in Photo-Paint) and choose "LightMachine" from the PhotoWiz sub menu.

If LightMachine appears grayed out on the menu, then the mode of the opened image is not supported by it. That is the
case if your image has e.g. only 256 colors, 32-bit per channel or is a CMYK image. Then you have to convert it in your
image application to RGB before you can start working on it with LightMachine. In Photoshop that is done on the Image >
Image Mode menu.

1.5.2 Running the Standalone

To run the standalone of LightMachine, double click the LightMachine icon on the desktop or choose it from the Start > All
Programs > The Plugin Site > LightMachine Standalone menu. After LightMachine shows up click the Open button in the
bottom right corner to open one or more image files. You can also click arrow-down button in the top left corner to display
a menu with file options.

1.5.3 Running the Lightroom Version

To run LightMachine in Lightroom, select one or more images and choose the LightMachine menu item on the Photo >
Edit In menu. Alternatively you can also right click on an image and choose Edit In > LightMachine from the context menu.
The following dialog will appear:
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If you selected RAW files, you will only be able to select the option "Edit a Copy with Lightroom Adjustments". If you edit a
JPEG or TIFF file, you will also see the other two radio buttons. We recommend that you use the first or second option in
this case. Never use "Edit Original" unless you have a backup copy of the file(s).

We suggest that you keep the Copy File Options settings as they are to avoid reduced image quality or a slower startup of
LightMachine. By using "ProPhoto RGB" for the Color Space option you preserve the as much image colors as possible. If
you use other external editors in Lightroom that do not support color management, changing the option to "sRGB" may be
a viable compromise. If you do not use the "16 bits/component" setting, you may get reduced image quality. If you do not
use the "None" compression settings, LightMachine will need longer to start up. On the other hand the "Stack with
original" keeps the original and LightMachine-processed copy of the image side by side in Lightroom, so it is rather a
question of your workflow if you want that or not.

Finally press the Edit button to run LightMachine. If you if you selected RAW image files, Lightroom now creates TIFF
copies of them, which may take some time. For JPEG and TIFF files LightMachine appears much faster.

1.5.4 Running the Lightroom Version in ACDSee (Pro / Ultimate)

To run LightMachine in ACDSee switch to Manage or View mode, select the image you want to edit and choose Tools >
External Editors > LightMachine from the menu.

1.5.5 Running the Lightroom Version in AfterShot Pro

To run LightMachine in AfterShot Pro, right click on one of the thumbnails in the thumnbail panels and choose the Edit
with > LightMachine from the context menu. Alternatively you can use the Edit > Edit with > LightMachine menu item from
the top.

1.5.6 Running the Lightroom Version in CaptureOne

To run LightMachine in CaptureOne, select an image from the browser, choose File > Edit with… from the main menu (or
right click from the browser and select Edit With…). Select TIFF or PSD as the image format from the appearing dialog,
choose 16-bit as the bit depth and no compression. Choose Other from the Open With…drop down menu and navigate to
the LightMachine installation folder. Finally click on the Edit button to run LightMachine. Alternatively the File > Open
with… menu item lets you edit the original image file, which is usually not recommended.

1.5.7 Running the Lightroom Version in DxO Optics

To run LightMachine in DxO Optics, open an image and go to "File > Export to application" from the main menu or right
click on a thumbnail and select "Export to application". In the appearing dialog click the Browse button, choose the
LightMachine installation folder from the file dialog, e.g. at C:\Program Files\The Plugin Site\, and double click on the
LightMachineLR.exe file. From the Action combo box select the item "Process as TIFF and export" and under Quality
choose "16-bit". Finally click the Export button. Click OK on the LightMachine dialog when you are finished and back in
DxO Optics click on the newly created thumbnail to see the result.  The next time that you go to File > Export to
application you can choose LightMachine from the Export to combo box and do not need to locate it first.

1.5.8 Running the Lightroom Version in Exposure

To run LightMachine in Exposure X2 or higher, select an images at the bottom, right click on the thumbnails or the
displayed image and choose the Edit Copy In > LightMachine from the context menu. Please note if you use the Edit In >
LightMachine menu item, the original file will be overwritten when clicking OK in LightMachine.
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1.5.9 Running the Lightroom Version in ON1 Photo Raw

To run LightMachine in ON1 Photo Raw, open an images file and choose File > Send to Other Application... from the
menu. Now choose the LightMachine installation folder from the appearing file dialog, e.g. at C:\Program Files\The Plugin
Site\, and double click on the LightMachineLR.exe file. On the appearing Edit In dialog choose "Edit a Copy ...", from the
File Format combo box select "Photoshop" and from the Bit Depth combo box select "16-bit". Choose a color space as
you see fit. Finally click the Edit button. ON1 Photo Raw now creates a new image and runs LightMachine. In
LightMachine click OK to save the effect.

The next time you do not need to use the File > Send to Other Application menu item, because there will be a dedicated
File > Send to LightMachine menu item available, which you can use.

1.5.10 Running the Lightroom Version in Raw Therapee

At first you have to enter the path of LightMachine under Preferences > General > External Editor > Other command line.
The path should usually be e.g. "C:\Program Files\The Plugin Site\LightMachine\LightMachineLR.exe" or "C:\Program
Files\The Plugin Site\PhotoWiz\LightMachineLR.exe", but please check yourself in Explorer to be sure.

To run LightMachine in Raw Therapee click the "Edit Current Image in External Editor" button on the Editor tab or at the
bottom-left of the Preview panel.
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1.6  Workflow

When correcting photos it is often important in which order you preform certain correction steps. Applying the same
correction steps in a differen order may produce a less good final result.

1.6.1 ColorWasher, LightMachine and FocalBlade

Although our ColorWasher and LightMachine plugins can both adjust color and brightness in images, they do so in a very
different way and produce very different results. Both tools achieve great results in their own respect. The plugins were
created for quite different image processing tasks and complement one another nicely. For some images you will only
need ColorWasher, for some you will only need LightMachine and for others you will need both. FocalBlade provides the
final essential correction tool as it enables you to enhance the clarity of detail, or sharpness, of your photos.

You should use ColorWasher for correcting photos which are completely under or overexposed, as well as those with
overall color cast problems. It lets you correct such images automatically and very quickly. LightMachine, on the other
hand, is needed to make refined adjustments to the specific problem areas in partially under or overexposed photos,
and/or to make sophisticated brightness and contrast corrections.

If you need to use both plug-ins to work on different aspects of the same photo, you should use ColorWasher before you
run LightMachine, otherwise you may worsen or emphasize the color cast when using LightMachine. In such a case
please try to avoid using the Exposure and Highlights/Shadow features in ColorWasher. Manipulating the brightness in
ColorWasher may prevent LightMachine from producing the best results in certain image areas, but first using Auto
Contrast in ColorWasher may help LightMachine achieve a better result. A color shift can become visible after lifting
shadows using LightMachine, but this problem can be dealt with using its features for correcting specific image areas.

While ColorWasher should be used before LightMachine, FocalBlade should ideally be applied only after your color
corrections have been completed. If you use FocalBlade before ColorWasher and LightMachine, it is possible that the
sharpness effect might be increased or decreased, which can result in artefacts.

1.6.2 LightMachine and Other Tools

Correcting the brightness or contrast of a photo with any other tool before using LightMachine is not recommended as this
might detrimentally affect the quality of Light Machine's results.

If preferred, you can also use LightMachine only as a masking tool and do your corrections with other tools. To do this you
can render the mask to the image by activating the N or P button and pressing OK. The resulting B/W mask can then be
used as a layer mask. Alternatively you can run LightMachine on a layer, activate the S or H button and press OK. The
mask will make certain areas of the layer transparent.
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1.7  General Usage

1.7.1 The Main Dialog

The Preview and Zoom options

On the left-hand side of the dialog box is the preview box that shows you what the final effect will look like. Controls to
adjust the preview zoom level are located below the preview. You can zoom the image between 6% and 3200%. When
starting LightMachine the zoom rate is automatically set to Fit, which displays the image completely in the preview. The
100% option means that the original size of the image is displayed. There are Fit and 100% buttons at the left for quickly
switching between these zoom states. To jump from one preview zoom rate to another you can use the zoom combo
box which is located between the two zoom buttons. With the Ctrl and minus/plus key shortcuts you can also change the
zoom ratio.

Changing the Window Size

To resize the LightMachine window and make the preview larger under Windows you have to move your cursor to the
border of the LightMachine dialog. The cursor will then turn into a double arrow. Holding down the left mouse button and
dragging the mouse changes the size of the window. You can also drag the handle at the bottom right of the LightMachine
dialog. Click the maximize button on the right side of the LightMachine title bar to enlarge the window to full screen.
Clicking it again restores the old window size.

Enlarging the preview also increases the time that LightMachine needs to update it. On the other hand making it smaller
makes LightMachine render the preview faster.
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The Tools

There are a few icons at top right corner of the preview, which lets you do various operations on the preview.

You can scroll the image in the preview by activating the hand tool and dragging the image with it. You can also use it to
click on the preview to reveal the original image. While being moved, the original image is shown and after you release
the right mouse button the preview is recalculated. If one of the other tools is activated, you can also scroll the image by
holding down the right mouse button and dragging.

With the eyedropper tool you you can click somewhere on the preview to select a certain color for one of the color boxes
on the Color tab sheets.

The cross tool allows you to move and select the spots in the Virtual Studio modes or activate a color in the color mask
of the Color modes. Read more on the Spot Mask and the Color Mask pages.

The split view tool lets you move the separation lines in the preview or choose a focus point in case the Multi check box
is activated. When you choose the split view tool, the split view feature is automatically activated. Read more on the Split
View page.

Modes & Basic Design

LightMachine features nine different modes which can be selected from the combo box at the top. There are only four
basic filters (Brightness/Contrast, Shadows/Highlights, Virtual Studio and Colors), but each of them is available in basic
mode as well as Pro mode. As a novice you should start with the basic modes and then try the Pro modes (which allow
more sophisticated corrections) after you have mastered the easier modes. For more information on the various modes,
please read the Modes page.

LightMachine contains three tab sheet controls at the right side of the preview. The first tab sheet offers controls for
adjusting the brightness, contrast, colors and saturation in the image. The second tab sheet control in the middle contains
controls for adjusting the mask that controls with which intensity the effect is applied to which image area. Finally, the third
tab sheet control at the bottom contains the Help box, the histogram view, the Info tab sheet and the Preferences.

The Reset Button

Clicking the Reset button sets all controls to their default values. This is useful if you want to start over with adjusting the
effect. Clicking the arrow down button displays a context menu with various reset options. See the Reset, Undo & Presets
page.

Sliders

Although there are various other controls available for adjusting the image effect the main controls are sliders. Sliders can
be used to select a certain value within a specific value range. To do that you can drag the slider knob with the mouse (or
keyboard), enter a numerical value in the white text box at the right of the slider bar, click somewhere on the slider bar for
large value steps or use the two arrow buttons for small value steps. If the  Instant Preview check box on the Prefs tab
sheet is not activated, you can hold down the Shift key while dragging the slider knob to make the preview update with
every movement of the knob. If the Instant Preview is activated, you don't need to hold down the Shift key for the same
effect.

You can now also use the mouse wheel to change the slider values. You need to give the slider the focus by clicking on it
or using the tab key. After that you can scroll the mouse wheel to move the slider knob. After you stopped moving the
wheel the preview will automatically update.
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The Fade Slider

The Fade slider lets you weaken the overall effect of LightMachine. A value of 100 will apply the effect at full strength,
while a value of zero won't change the original image. This slider is useful if you don't want to mess with many other slider
and want to weaken the global effect of LightMachine.

The Bottom Tab Control

The Help tab sheet makes it easier for new users to get started and makes it possible to use LightMachine without a
glance at the manual. It can provide useful hints and assist you in the B/W conversion process. If you move the mouse
over a certain control, the text box will display some explanations and hints about that control. After you know all about
LightMachine, you can deactivate these explanations by deactivating the check box in the bottom right corner of the Help
box. We recommend that you keep it activated.

The Histo tab sheet displays various histogram of the image. The Info tab sheet shows color values of the image pixels.
Finally, the Prefs tab sheet contains options for changing the general behavior of LightMachine. Please read further on the
following pages: Histo Tab, Info Tab, Prefs Tab.

The Preview Check Box and Progress Bar

A deactivated Preview check box does not render the effect and therefore does not display any effect in the preview. This
way you can see before/after versions of the image and adjust a number of controls without provoking a repeated
rendering of the effect. When the effect is rendered, you see a bar running from left to right in the progress bar control.
After the rendering is completed and the preview updated, the time that was needed for rendering is displayed as well as
an approximation of the time that is needed to render the full image.

Split View & Multi

LightMachine offers various split views for comparing the original with the processed image. For more information, please
read the Split View page.

Open, Save, Exit or OK, Cancel

When using the Plugin version clicking on the OK button exits LightMachine and applies the effect to the image. The
current settings are saved and restored when you use LightMachine again in case you have the Previous Settings item
activated in the On Start Up combo box in Preferences. The Cancel button simply exits LightMachine without changing
the image. If you hold down the CTRL key while clicking on Cancel, you will be prompted for Cloak Mode. In Cloak Mode
the current settings will be applied to the images without displaying the LightMachine dialog. For more information, please
read the Cloak Mode page. The Cloak Mode feature only works in the Plugin version.

When using the Lightroom version clicking the OK button makes LightMachine process the opened images.
LightMachine automatically exits after all images were saved and you can continue working in Lightroom. Cancel exits
LightMachine and does not apply an effect to the image(s).

In the Standalone version the Open button lets you can open one or more images with the help of a file dialog. The Save
As button displays a file dialog for entering a file name and choosing the image format. Then it renders and saves the
image. You can read more about it on the Standalone page.

You can also cancel or exit LightMachine by clicking on the x button in the title bar.

The ? buttons displays the html manual.
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1.7.2 Differences between the Plugin, Lightroom and Standalone Versions

If you only open one image in the Lightroom version of LightMachine, you see no difference to the Plugin version. If you
select two or more image in Lightroom, the Lightroom version of LightMachine displays an Images tab control left of the
preview. This Image tab is also displayed in the Standalone version if you open more than one image. It lets you switch
between the images.

As result of displaying the Images tab control the preview gets smaller. To increase the preview size again please enlarge
the LightMachine window. See below for instructions.

The Standalone version on the other hand offers a few more features than the Lightroom and Plugin versions of
LightMachine. That is because it does not rely on another program for opening and saving image files. As a result the OK
button of the Lightroom and Plugin versions is replaced by Open and Save As buttons for opening and saving image files.
The Cancel button is called "Exit", which saves the effect settings unlike the Cancel button. Additionally the Standalone
versions offers an arrow-down button in the top left area of the window below the title bar. Clicking on it displays an menu
with various options.

Apart from these small extras and changes, all versions of LightMachine behave and work the same. For more
information visit the Standalone/Lightroom Features page.
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1.8  Standalone/Lightroom Features

This section discusses the features that are only available in the Standalone and Lightroom versions of LightMachine.

1.8.1 Opening Images

The Lightroom version of LightMachine does not let you open any images. You need to select the images in Lightroom
before running LightMachine.

The Standalone version supports various ways of opening images. There is an Open button at the bottom right of the
window or an Open menu item displayed when you click on the arrow-down button at the top left corner of the preview.
Both displays an file dialog for selecting image files. To select multiple image files please hold down the Ctrl or Shift key
and click on them. Alternatively draw a rectangle around them to select them.

Another way of opening image files is to drag them, e.g. from Explorer, and drop them on the LightMachine window. It is
also possible to drag and drop files on the LightMachine icon on the desktop. This runs LightMachine and immediately
opens the dropped images. Yet another way to open image files is to run LightMachine from the command line.

1.8.2 RAW Settings

When opening camera raw files with the Standalone version, the Options dialog shows up by default. If you do not want
that, please activate the "Don't Display" check box. You can then still change these settings from menu of the
arrow-down button at the top left corner of the preview. You can also access this dialog from the Save Options and Batch
dialog as discussed below.

The RAW tab sheet of the Options dialog defines how the raw image data will be converted and preprocessed before it
shows up in LightMachine.

The Preview group contains options that are used when opening RAW images for preview display. The Output group
options are used when saving or batch processing images. With default settings RAW images are opened at quarter size
for preview display, which speeds up the loading. Before applying the effect and saving the image, they are reopened at
full size. There is also an option to open the JPEG image that is embedded into the RAW file (that currently only works for
CR2 raw files), which is only recommended for the Preview group, unless you want to quickly convert your RAW files for
the web or screen display.
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The White Balance combo box controls the automatic white balancing process. The Camera Settings option performs a
color correction according to the data stored in the RAW file. The Automatic option white balances the image according to
the image data. If you do not want to apply a color correction, simply choose the None option.

The Color Space options let you choose the color space of the image. "sRGB" retains the least color information, but is
practical if you want to use the image for the web or screen display or if you want to open the image later in an application
that does not support color management. If you plan to print the image professionally, you should rather choose "Adobe
RGB" or "ProPhoto RGB". The ProPhoto RGB color space preserves the most color information.

The Neutral Look check box performs less preprocessing of the RAW file, which makes the image look a bit flat but may
not cut off any shadow or highlight values. So this option is recommended for photos with a lot of information in highlight
and shadow areas. If this check box is deactivated more preprocessing is applied, which will probably be what you may
want for most images.

The 4-Color-Sensor check box is meant for RAW files that were captured with a camera that uses a 4-color-sensor. If
raw files have artifacts when displayed, you should try this option.

The Defaults button restores the default settings, which can be seen in the screen shot above.

1.8.3 Switching Between Images

If you open more than one image, a Images tab control appears on the left hand side of the preview. The Images tab
sheet contains a list box with the names of the opened image files. By clicking on one of them you can display them in the
preview. You can also switch between the images by using the Images sub menu of the arrow-down button that is located
at the at the top left corner of the preview. This sub menu lists all opened image files.

LightMachine does not load or keep the images in memory. It loads an image as you select it and removes it from
memory when selecting another image. So displaying a big image for the first time may take longer, but on the other hand
opening multiple images is instant or only takes the time of loading one image. Additionally it avoids that image
processing operations get slow because of low memory.

1.8.4 Using Different Settings for Each Image

There is an Individual Settings check box located at the bottom of the Images tab sheet. It is activated by default, which
means that you can adjust each image differently. When switching from one image to another, the settings of the old
images are automatically saved and the settings of the new image are restored. If you switch to an image for the first time,
it takes over the settings of the previous image. When saving or batch processing the images, these individual effect
settings are used for processing each image.
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If this check box is deactivated, each image will be processed with the same effect settings. The currently displayed
settings are then applied to all images. You can also deactivate and activate the check box again to delete the stored
individual settings, e.g. in order to start again adjusting the settings for each image.

1.8.5 Closing an Image

Closing an image is only possible with the Standalone version. If you are using the Lightroom version, you need to cancel
LightMachine, return to Lightroom to deselect the image(s) and run LightMachine again.

Closing an image means that the currently selected image is removed from the Images list box and the next image on the
list is displayed. If you only have one image open, the preview becomes blank when closing that image. You can close an
image by using the Close button at the bottom of the Images tab sheet or by choosing the Close item on menu of the the
arrow-down button at the at the top left corner of the preview. The Close All option on the same menu closes all opened
images.

1.8.6 Saving an Image

The Lightroom version applies the effect and automatically saves the images when you press the OK button. It does not
offer any special save options.

The Standalone version on the other hand offers various options for saving the displayed image. You can use the Save
As button at the bottom right or the Save As menu item on the menu of the arrow-down button located at the top left. Both
display a file dialog for choosing a folder, editing the file name and choosing an image format. After you pressed the Save
button on the file dialog a Save Options dialog appears. On this dialog you can choose additional file format options.

The Save Options dialog lets you change the image format and adjust additional settings. For the JPEG format you can
choose a quality setting and for the TIFF format you can select a lossless compression type. If at least one of the current
images uses 16-bit/channel, you are also able to use a "Reduce to 8-bit/channel" check box for the TIFF, PSD and PNG
format. The "Convert to sRGB" option lets you convert the image to the sRGB profile in case it uses another profile. If you
do not want to have any meta data added to the saved file, please activate the "Do not save meta data" check box.

A button that displays the RAW Options dialog is also available here. It lets you readjust the settings for camera raw files.
In this case only the settings on its Output tab sheet have an effect. We do not recommend changing its Look or White
Balance options, otherwise the end result will differs from what you saw in the preview. See above for more information on
the RAW Options.

After you press OK on the Save Options dialog, the effect is applied to the image and the image is saved.
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1.8.7 Batch Processing

Whereas the Save As command only lets you save one image, you can also process and save all opened images in one
pass with the Batch command of the Standalone version. The Lightroom version does not offer a Batch command, but
when you press its OK button, it automatically starts batch processing without showing a dialog.

The Batch feature of in the Standalone version processes all opened images, so if you want to process only some of the
opened images, please close the others. You can be access it by pressing the Batch button on the Images tab sheet or
with the Batch menu item of the arrow-down button located at the left top. This brings up the Batch dialog.

On this dialog you can choose the image format and its options (see Save Options above), an output folder and a suffix
that will be appended to the file name. Clicking on the Choose button displays a folder selection dialog which also offers
an option for creating new folders. If you only want to convert the image(s) to another image format without applying an
effect, you should activate the Deactivate Effect check box.

The RAW Options button displays a dialog for adjusting the raw file output. In this case only the settings of its Output
group have an effect. We do not recommend changing its Look or White Balance options, otherwise the end result will
differs from what you saw in the preview. See above for more information on the RAW Settings.

After you pressed the Batch button LightMachine starts processing all opened images. A window with a progress bar
appears that tells you how many images still have to be processed and how long it will approximately take.

1.8.8 Color Management

Whereas color management support depends on the host application for the plugin version, the Standalone and
Lightroom versions of LightMachine fully supports color management. This means that LightMachine uses profiles that are
embedded in JPEG, TIFF and PNG files to correctly display the image colors. Concerning camera raw files LightMachine
automatically converts the image to a selectable color space (see the RAW Settings section above). Color management is
currently not supported for image formats other than the four mentioned ones. For other image files and for images
without a profile LightMachine automatically assumes that they contain sRGB data.

Embedded profiles are preserved when opening JPEG, TIFF and PNG files and saving them again. If an image file does
not includes a profile but mentions the sRGB color space in its EXIF data, LightMachine automatically embeds a sRGB
profile when saving the image. When saving RAW files as JPEG, TIFF or PNG, a profile is also embedded. When saving
an image as PSD, no profile is embedded.

You can adjust the color management options by choosing "Options" from the arrow-down menu at the top left corner of
the preview and then switching to the Color tab sheet.
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The Deactivate Color Management check box avoids that the embedded or assigned profile is used for displaying an
image. This means that images with a different color space than your monitor will be displayed incorrectly. For example,
an Adobe RGB image will be displayed with faded colors on a sRGB monitor. Unless you have a good reason, we do not
recommend activating this option.

The Use Monitor Profile check box makes LightMachine use the profile, which is set at Start > Control Panel > Display
> Settings > Advanced > Color Management, as the target profile when displaying images. In most cases it is wise to
keep this check box deactivated. Then LightMachine assumes that your monitor supports sRGB (which is the case for
99.9% of all monitors) and uses the sRGB profile as the target profile. LightMachine also assumes that your monitor is
calibrated.

There are only two possible reasons for activating this check box:

1. Your monitor supports another color space than sRGB and you have set the appropriate profile at Start > Control Panel
> Display > Settings > Advanced > Color Management. For example, if your monitor is an Adobe RGB monitor and you
have set the Adobe RGB profile at the mentioned location. Then activating Use Monitor Profile check box makes sure that
LightMachine displays the colors correctly on your non-sRGB monitor. Please notice that your monitor additionally needs
to be calibrated and the calibration applied when Windows starts up, otherwise you will still not see the image colors
correctly.

2. Your monitor was not calibrated and no calibration data is loaded when Windows starts up, but you have a monitor
profile from the manufacturer, which you want to use and which you have added under Start > Control Panel > Display >
Settings > Advanced > Color Management. Be aware that only the image in LightMachine (and other applications that
support it) will be displayed with correct colors. The rest of the screen is displayed uncalibrated and with incorrect colors.
This is only an emergency solution. We recommend that you calibrate your monitor instead.

The Conversion group offers two option for defining how LightMachine converts the colors when displaying an image.
The Intent combo box offer four choices that control the method that is used for mapping the colors from the source color
space to the target color space. The activated Black Point Compensation check box changes the black point during the
conversion to better match the target color space. In many cases changing these settings has only little influence, but we
recommend to keep "Relative Colorimetric" and the Black Point Compensation check box activated. For more information
please read the web or literature about color management.

1.8.9 Metadata and Auto Rotation

LightMachine currently preserves the metadata of JPEG files (e.g. EXIF, IPTC) when saving the image again as a JPEG.
When opening and saving TIFF images, LightMachine only preserves the XMP, IPTC and Photoshop tags. When saving
an image as a different format, no metadata is currently preserved. This will be fixed in a future update.

In Adobe Lightroom you can copy the original metadata to the LightMachine-processed images by selecting all images,
e.g. with Edit > Select All, and choosing Metadata > Sync Metadata.

Some cameras add EXIF data to JPEG and RAW files if the photo was shot at a 90 degree angle. LightMachine checks
for this information and automatically rotates the image before displaying it.
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1.9 Step By Step Guide

1.9.1 Correcting the Whole Image

1. Switch to "Brightness/Contrast Pro" mode with the Mode comb box at the top.

2. Click on the Reset button to undo all previous changes.

3. Adjust the Brightness slider. If blown highlights (uniform white areas) appear, reduce the value of the
Brightness slider.

4. Adjust the Contrast slider. If the value is too high, some areas in the image will become too dark. If
the value is too low, the image will appear too gray.

5. Carefully adjust the Amplify slider if you are not satisfied the effect. You may need to readjust the
Brightness and Contrast slider if you use a too high or low value for the Amplify slidier.

6. If necessary you can use the Local Contrast slider to compensate a low Contrast slider value or to
remove a hazy effect. For that purpose, slowly increase the value of the Local Contrast slider and
observe the effect.

7. Adjust the Radius slider to modify the local contrast effect. Readjust the Local Contrast slider if
necessary.

1.9.2 Correcting Shadows and Highlights

Starting

1. Switch to Shadows/Highlights Pro mode using the Mode combo box at the top.

2. Click on the Reset button to undo all previous changes.

Adjusting brightness and contrast to see the effect

LightMachine Manual 27



3. Increase the value of the Brightness slider of the Shadows tab sheet until the dark areas in the image
become more visible without getting too bright.

4. If the shadows look too burnt, try a negative value for the Contrast slider. If they look too gray and flat,
try increasing the contrast.

5. Carefully adjust the Amplify slider if you are not satisfied with the effect. You may need to readjust the
Brightness and Contrast sliders if you use too high or low a value for the Amplify slider.

Using Auto Mask for adjusting the shadow mask (Skip to step 11 if you want)

6. Start with the "Very Deep" setting in the Shadow Depth combo box of the Auto Mask tab sheet. Try
the various Shadow Depth settings to see which best reveals the shadow areas without brightening the
highlight areas.

7. Choose "Low Contrast" or "High Contrast" from the Image Type combo box. Depending on which
setting you choose the next combo box will be called "Shadow Shift" or "Anti-Alias".

8. Choose one of the settings from the Shadow Depth or Anti-Halo combo box. If you choose too high
an option for Shadow Depth the borders between the shadow and highlight areas might be too dark.
"Method 2" in the Anti-Halo combo box effectively reduces halos, but can have a negative impact on the
appearance of some images. If that's the case, try Method 1. If there are no improvements, turn
Anti-Halo "Off".

9. Starting with the "Very Fine" setting in the Details combo box, cycle through the options to find which
produces the best results for your image.

10. Try all options from the Color Filter combo box. "Green" will work well in many casesby removing
greenish areas from the shadows and adding them to the highlights. If you want to add green areas in
the image to the shadows, please select its opposite color "Magenta". Other images may need another
color filter.

Fine-tuning the mask (Skip to step 19 if Auto Mask worked perfectly)

11. The Auto Mask tab sheet is a good place to start for adjusting the shadow mask, but in some cases
you will need to switch to the Fine-Tune tab (see step 18) to improve the mask even more. Tip: Clicking
on the label of one of the Auto Mask features, will switch the focus to its combo box. You can use the
Tab key to switch between the Auto Mask combo boxes - Tab will move you down one box, Shift+Tab
will move you up one box. Use the left and right arrow keys to move up and down through the options in
the combo boxes.

12. If necessary use the Threshold slider to define the border between the shadows and highlights even
more precisely.
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13. Keep the Range slider to zero unless you want to partially affect the highlights with the shadow
correction, too. That is usually necessary for images that don't have strict shadow/highlight borders.

14. The Shift slider lets you shrink the shadow areas to create a smoother transition between shadows
and highlights or to reduce halos. Lower values usually work best.

15. The Anti-Halo slider is for reducing halos in case the Shift slider doesn't help. However, it can also
reduce the quality of the correction, so use with care.

16. The Radius slider has an effect on the size of a halo and the diffusion of the light. It can also be used
to create a smoother transition between shadows and highlights.

17. The Color Filter slider lets you exclude or include image areas of a specific color from the shadows
or highlights. Setting it to a green value will exclude green objects from the shadows and include
magenta ones in the shadows. At the same time it will include green objects in the highlights and
exclude magenta objects from the shadows. The same is true for all other colors and their opposing
colors.

18. Try the N, P, S and H buttons to see the mask that you have created. Having one of them activated
while adjusting the mask can be helpful.

Readjusting the effect

19. After you have followed these steps you may want to readjust the Brightness and Contrast sliders on
the Shadows tab again.

20. If the shadows have been brightened too much, the edges of image objects may appear too flat. You
should be able to recover these details with the Local Contrast and Radius sliders. In other cases better
results can be achieved by using lower values in the Contrast slider to reveal more darkened areas and
adjusting the Local Contrast slider to add back contrast.

21. If you notice that the lifted shadow areas have a color cast, please switch to the S-Color tab and try
the four sliders at the top. If the shadow areas contain an almost gray or white area, try the following:
Click on the A button and then click on the almost gray or white area in the shadows. If that doesn't
work, try again or Shift click the S-Color tab button to reset the controls of the S-Color tab.

22. Adjust the Saturation slider if the shadows look too gray or too colorful. Try the other options of the
combo box on the left of the slider to avoid color noise or oversaturation.

Correcting the Highlights

23. Some images may require that you also adjust the highlights to make them better match the lifted
shadows or to make them less bright or faded.

24. Switch to the Highlight tab sheet and use the brightness, contrast, color and saturation controls as
you used them for correcting the shadows.
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1.9.3 Using Virtual Studio Mode

Starting

1. Switch to Virtual Studio Pro mode with the Mode combo box at the top.

2. Click on the Reset button to undo all previous changes.

Adjusting Brightness and Moving the Spot

3. Increase the value of the Brightness slider of the Spots tab sheet until the default spot in the image
becomes visible without getting too bright. Because the Brightness slides affects ALL spots, Brightness
should always be set for the brightest spot. Less bright spots can be achieved by selecting each spot
and adjusting the Intensity slider. Please see point 11.

4. Click on the cross of the spot and drag the spot to a place on the image that you want to change.

Adjusting the Spot

5. If you want to create a shadow spot instead of a light spot, please use a negative value for the
Intensity slider on the Spot Mask tab sheet.

6. Adjust the Size slider until the spot has the right size.

7. Adjust the Ovality slider if you want to spot to only cover an oval area. After that use the Angle slider
to rotate the spot if necessary.

8. Adjust the Hardness slider to make the center of the spot brighter. You may want to readjust the
Brightness or Intensity slider after that.

9. Use the Reflection slider to make the spot less or more bright on certain image areas. If the spot
produces halos, reduce the value of the Reflection slider or use the Shift and Ant-Halo sliders from the
Reflection tab sheet. You can fine-tune the reflection properties of all spots even more on the Reflection
tab sheet.

Creating a New Spot (Skip steps 10 to 12 if you don't want a new spot)

10. If you want to add another spot, please click on the image in the preview where you want to have it.
When you add a new spot, it will have the same properties as the last spot created or adjusted.

11. Adjust the Intensity slider on the Spot Mask tab sheet if you want to have the spot less bright than
the previous spot. If you want to have the current spot brighter, please increase the value of the
Brightness slider. Please see step 3.

12. Repeat steps 5 to 9.
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Readjusting the General Effect

13. After you have created as many spots as you need, you can simultaneously readjust the brightness
of all these spots with the Brightness slider on the Spots tab sheet.

14. Try the other sliders on the Spots tab sheet as well as the sliders on the S-Color tab sheet.

15. You may also want to readjust the reflection effect on the Reflection tab sheet.

Correcting the Background

16. For some images you may also want to adjust the area outside the spots. That can be done with the
controls on the Back and B-Color tab sheets.

1.9.4 Changing the Color of an Image Object

1. Switch to Colors Pro mode with the Mode combo box at the top.

2. Click on the Reset button to undo all previous changes.

3. In the preview please click on the object in the image that you want to colorize. Please click again on
another area if you want to include it as well. Shift click an image area to remove it again.

4. Switch to the Colors and C-Color tab sheets and adjust selected image area as you wish.

5. If the image object or areas aren't corrected or colored as you want it to, there are several
possibilities. You can use the Impact slider from the Color Mask tab sheet to intensify the effect.
Additionally you can set the Brightness, Contrast, Adjust, Red, Green, Blue and Saturation sliders to
more drastical values.

6. If necessary, switch to the Back and B-Color tab sheets and adjust the background areas.

1.9.5 Selective B/W Effects

Making the whole Image B/W with the exception of one or two colors

1. Switch to "Color Replace" mode with the Mode comb box at the top.

2. Click on the Reset button to undo all previous changes.

3. Set the Saturation slider from the C-Color tab sheet to -100.

4. Activate the "Invert" check box from the Color Mask tab sheet.

5. Click on the color in the preview that you want to keep colored.
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6. The image will now appear B/W with the exception of the areas with the selected color.

7. Use the Impact slider to make the colored area stand out better.

8. If you want to keep another color, click again on a new color in the preview. If you want to remove one
color and make it B/W again, hold down the shift key and click on it in the preview.

9. Again try using the Impact slider to emphasize the new colored area if necessary.

10. You can adjust the B/W effect by choosing another option from the Saturation combo box or by
using the Adjust, Red, Green and Blue sliders from the Color tab sheet.

Making the one or two colors in the image B/W

1. Switch to "Color Replace" mode with the Mode combo box at the top.

2. Click on the Reset button to undo all previous changes.

3. Set the Saturation slider from the C-Color tab sheet to -100.

4. Click on the color in the preview that you want to make B/W.

5. The color will now appear almost B/W in the preview.

6. Use the Impact slider to intensify the B/W effect.

7. If you want to make another color B/W, click again on a new color in the preview. If you want to make
that area colored again, hold down the shift key and click on it in the preview.

8. Again try using the Impact slider to intensify the B/W effect if necessary.

9. You can variate the B/W effect by choosing another option from the Saturation combo box or by using
the Adjust, Red, Green and Blue sliders from the Color tab sheet.

1.9.6 Using LightMachine as a Masking Tool

Obtaining the shadows and highlights as separate transparent layers

1. Duplicate the image on a new layer in your graphics application.

2. Run LightMachine.

3. Adjust the sliders in LightMachine as you wish to create a certain mask.

4. Activate the S button and press OK. As a result you will have the shadow areas on a layer. All other
image areas have become transparent.

5. For receiving the highlight areas on another layer please repeat step 1 to 4, but use the H button in
step 4.

6. Please keep the original background image, because some areas may be transparent on both
shadows and highlight layers.

7. Now you can selectively adjust the shadows and highlight layers with the tools of your graphics
application or with other plugins. You can also use LightMachine's Brightness/Contrast (Pro) mode on
both layers.
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Using the LightMachine mask as a layer mask

1. Duplicate the image on a new layer in your graphics application.

2. Run LightMachine.

3. Adjust the sliders in LightMachine as you wish to create a certain mask.

4. Activate the P button in LightMachine and press OK. That will give you the shadow/highlight mask as
a B/W image on the layer.

5. Now you can use the LightMachine mask as a layer mask by again duplicating the image as a new
layer, adding a layer mask and copying the LightMachine mask into the layer mask channel.

6. Now you can selectively adjust the image with the tools of your graphics application or with other
plugins. You can also still use LightMachine's Brightness/Contrast (Pro) mode.
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1.10 Tips for Tough Cases

Tip 1 - Don't Increase Brightness Too Much

Although it may be seductive to set a high Brightness value in LightMachine, you can easily overdo it. If the dark areas of
an image are brightened up too much, they will lose contrast and look unnatural.

Tip 2 - Think Simple

A good Brightness and Contrast value should be chosen before you start tweaking the mask options in
"Shadows/Highlights Pro" or "Virtual Studio Pro" modes. It can help to switch to the simple "Brightness/Contrast" or
"Brightness/Contrast Pro" mode and concentrate on the brightness and contrast controls alone. In these modes the whole
image will be affected, so you can see what would happen to the image parts, and which are already correctly exposed,
without a mask.

Tip 3 - Push the Contrast

Image areas that are brightened up easily lose contrast in the details. You can compensate for this loss by using the Local
Contrast slider. Sometimes you can even achieve better results by lowering the Contrast slider to make more details
visible, although they may appear more flat.  You can then increase the Local Contrast slider to regain the lost contrast .

Tip 4 - Start With Auto Mask

The Auto Mask options can be a good starting place when correcting an image. The Auto Mask combo boxes demand
only a few simple choices from you, so you can adjust the mask for the current image very quickly. For tough cases you
will have to additionally switch to the Fine-Tune mode and slightly adjust the sliders there.

Tip 5 - Try Virtual Studio as an Alternative

For a some images the Shadows/Highlight modes only produce half-satisfying results. In such cases you can often
achieve superior results by using Virtual Studio mode to place spot lights over the objects that need to be brightened.

Tip 6 - Avoiding Noise

If lifting shadow areas with LightMachine results in visible noise, you can use a third-party noise reduction tool to remove
it. An alternative is to reduce the brightness in the shadows to make the noise less visible. Also, please remember that
low-cost cameras are more likely to produce noise in the shadows. Setting your camera to its highest quality setting (for
less JPG compression) can avoid unnecessary noise in the shadows.

Tip 7 - Sleep On it and Try Again the Next Day

Sometimes when you are very enthusiastic or in a hurry to correct a photo, you might do a correction that isn't that
brilliant. If you have the time, it sometimes helps to leave a photo alone and to try correcting it again the next day. You
might find that you missed something the day before or produced a too extreme correction.
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2 General Features

2.1 Modes

Although there are only four primary filters in LightMachine (Brightness/Contrast, Shadows/Highlights, Virtual Studio and
Colors), they are split up into 9 different modes to make it easier for beginners to learn to use LightMachine. The basic
modes are recommended for beginners, because they offer only the more important controls. As you get to know
LightMachine more and more you should try the Pro modes, too. The Shadow/Highlight Pro, Virtual Studio Pro and Colors
Pro are the main modes of LightMachine, offer the most controls and let you achieve the best results.

Switching Modes

The different modes in Lightmachine work as seperate filters. If you change to another mode, the effect from the previous
mode is replaced by the effect of the new mode. If you want to apply two different modes to the same images, you have to
press OK to apply the adjustments of the current mode and then run LightMachine again to apply the effect of another
mode.

When switching modes several slider values (especially those of the upper tab sheets) are carried over from the previous
mode, which can be a big help if you want to try different modes on the same image. There two avenues when switching
modes that are useful:

Brightness/Contrast (Pro) -> Shadwos/Highlights (Pro) -> Virtual Studio (Pro)

Color -> Color Replace -> Color Pro

You can ignore the middle mode or last mode or start with the second mode or jump from a basic mode to a Pro mode as
long as you don't leave one of the two paths. However, it makes not so much sense switching between modes like Color
Replace and Shadow/Highlights Pro, because one mode targets the colors of colored objects while the other mainly
targets the brightness of dark or bright objects. So you have to expect that the same color and brightness values have a
different effect in both modes. Of course, it can be done and may be needed in some cases, but you have to expect to
heavily readjust the controls then.

The layout of the Mode combo box represents these two paths, so that you probably use them intuitively.

Brightness/Contrast

This mode just offers a Brightness and Contrast slider. They work much better on photos than the brightness and contrast
sliders that can be found in many graphics applications. For more explanations, please read the Brightness/Contrast
page.

Shadows/Highlights

The Shadows/Highlights mode offers only the most essential controls for independently adjusting the shadows and
highlights in the image.



Virtual Studio

The Virtual Studio mode offers most controls of the Virtual Studio Pro mode, especially the sophisticated Reflection
features. So it is more suitable for artistic light effects. It lets you place an unlimited number of light spots as well as
shadow shots all over the image by clicking on the preview. You can also select existing spots by clicking on their cross
and move them to another position by dragging them.

Brightness/Contrast Pro

In addition to a Brightness and Contrast slider, this mode also offers two sliders for adjusting local contrast. It is helpful for
images that need a strong contrast increase and the normal Contrast slider doesn't help anymore.  For more
explanations, please read the Brightness/Contrast page.

Shadows/Highlights Pro

The Shadows/Highlights Pro mode is the most flexible mode for correcting photos with shadow and highlight problems.
The huge amount of controls offer even more possibilities and lets you correct as good as any type of photo.

Virtual Studio Pro

In Virtual Studio Pro you can feel like in a real photo studio, but unlike the real thing you have unlimited light spots that
you can arrange. Additionally you can also place shadow spots on the image to remove the light from certain areas. The
Reflection features adapt the spots to the shape of the objects in the image and avoid blown highlights. You can create
these spots by clicking on the preview. You can also select existing spots by clicking on their cross and you can move
them to another position by dragging them.

The Brightness and Contrast sliders work on all spots simultanously, so they are for general adjustments. You have to set
them for the brightest spot and reduce the Intensity slider for all spots that should appear less bright. Same is true for the
color and saturation sliders.

Colors

Lets you adjust the brightness and contrast of image objects with a certain color. To select a color you just need to click
on the preview. To deselect it again please shift click on the same color in the preview.

Color Replace

Color Replace is a specialized version of the Colors Pro mode. It is intended for selectively adjusting the color of image
objects with a certain color. To select a color you just need to click on the preview. To deselect it again please shift click
on the same color in the preview.

Colors Pro

Lets you adjust the brightness, contrast, color and saturation of image objects with a certain color. To select a color you
just need to click on the preview. To deselect it again please shift click on the same color in the preview.
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2.2 Reset, Undo & Presets

2.2.1  Reset

If you want to restart with the default settings or just started processing on a new image, it is a good idea to click on the
Reset button. The Reset button performs the action that was last chosen on its menu. This menu appears when you click
on the arrow button to the right of the Reset button.

Clicking the small arrow button to the right of the Reset button displays a menu with various reset options. "Default
Settings" deactivates a lot of other controls, but activates the default setting for the Auto Contrast and Exposure Fix
options."Original Image" deactivates all corrections and displays the uncorrected image. "Preview Settings" loads the
settings that were used for correcting the previous image. "Own Defaults" opens the preset file that was either already
specified, or if this is not the case, will prompt you for one. "Logged Settings" will try to open a preset that was
automatically saved when you corrected the same image the last time.

2.2.2  The Top Arrow-Down Menu

If you click on the arrow-down button at the left of the Mode combo box, a menu will be displayed. This menu includes
options for opening and saving presets and a list of all presets from the presets folders. A preset is file that stores the
effect settings of LightMachine. It can be used to restore often needed settings.

Open Presets

Several global presets are already delivered with LightMachine, which can be useful as a starting point. They only deliver
rough values, but they may be useful as a starting point for a manual color correction or artistic effect. They are located in
the Presets sub folder of the installation folder. They change all settings of LightMachine. In contrast to that the local
presets, which are located on tab sheets, only influence a few controls.

When you choose the Open Preset menu item, a file dialog displaying the files of the Presets sub folder appears and let
you select a preset file. The folder of the last opened preset is displayed by default in the file dialog.

Save Preset
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You can save the current LightMachine settings as a preset with the help of the Save Preset menu item. Please save
presets into the Presets sub folder at

Windows 2000/XP: c:\Documents and Settings\<user>\Application Data\ThePluginSite\LightMachine\
Windows Vista/7: c:\Users\<user>\AppData\Roaming\ThePluginSite\LightMachine\

otherwise they will not appear at the bottom of the menu.

You can open a saved preset again with the Open Preset menu item or by selecting them on the same menu.

Undo / Redo

The Undo / Redo option restores the control settings that were used before the preview was updated, because you
changed a slider value, pressed a button or moved a spot light. If you didn't do any changes to the LightMachine settings
and select this command a second time, it will perform a Redo and restore the settings that were used before you used
the Undo / Redo command for the first time.

Preset Items

At the bottom of the menu is a list of LightMachine presets. In case you already saved presets in the application data
folder (see "Save Preset" above), they are displayed first followed by a separation line. Then the included presets, which
are located in the Presets sub folder of the installation folder, are shown.

If you choose a preset from this menu, it is immediately applied and changes all settings. Choosing a preset directly from
the menu, is faster than hunting it with the Open Preset command.
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2.3 Split View

The various split views let you compare original image and result.

Using Left, Right, Bottom and Top View

These four split views let you compare the original image with the corrected version side by side. The corrected image will
be displayed at the left, right, top or bottom as the names indicate.

To move the separation line between the two versions, activate the split view tool and drag on the preview. If you have
Instant Preview from the Prefs tab sheet activated, the effect of moving the separation line will be immediately visible.

The Multi Check Box

The Multi check box only work in combination with the Split View options. If it is activated you will see the same image
content in each split view area. With the split view tool activated, you can click on the prreview to display a different part of
the image in the split areas. If the Instant Preview check box from the Prefs tab sheet is active, you can alternatively drag
with the split view tool over the preview to make it scroll. If Instant Preview is switched off, it makes no sense to drag,
because you won't see anything moving.

There is one things that you should also know about Multiple mode. If you activate the Multiple check box in Virtual Studio
(Pro) mode, the spot crosses will disappear and you will not be able to edit the spots. To edit the spots or add new ones
you need to deactivate the Multiple check box.
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2.4 Histo Tab

Basically histograms don't show anything you can't see in the image itself if you know where to look and look really
closely. But histograms have the advantage that they are more structured than the image itself, so they let you recognize
image problems easier.

A histogram is a statistical display of an image parameter, e.g. brightness, hues or saturation. It shows the distribution of
certain pixel values in an image. These values usually range from 0 to 255 in a 8bit image. The range of these values is
displayed from left to right in the histogram, so the value 0 is displayed at the outer left and the value 255 is displayed on
the outer right side. The amount of each value is displayed from bottom to top, so the height of the curve represents the
number of pixels that have a certain value. If more pixels have a certain value, the histogram curve will be higher at that
point.

In LightMachine the histogram curve is separate into three areas: the shadows on the left side (with values from 0 to 85),
the midtones in the middle (with values from 86 to 170) and the highlights at the right side (with values from 171 to 255).
LightMachine displays all three areas equally wide, although some people may argue that the midtones are double as
wide as the shadows and the highlights. But usually it more useful to define the three areas equally wide.

Peak, Mean, Shadows, Midtones and Highlights labels

The Peak figure lets you know which brightness, color or other value occurs most often in the image. The histogram curve
usually has its peak at that value. The Mean figure tells you the average brightness, color or other value. If this value is
below 128, the image contains e.g. more dark then bright areas.

The Shadows percentage lets you know how much of the image is in the lower value range (e.g. is quite dark), the
Midtones figure tells you how much of the image is in the middle range (e.g. is moderately bright) and the Highlights
percentage shows you how much of the image is in the upper range (e.g. is bright). For example if the Shadows
percentage in the RGB or Intensity histogram is very high, it can mean that the photo is underexposed.

RGB Histogram

You can use the RGB histogram to see if there are blown highlights or cutoff shadows in an image. Blown highlights can
be identified by a high spike at the right side whereas cutoff shadows are represented by a high spike at the left side. The
higher and wider the spike is, the more information was cut off.
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If there is large slope on the left or right side and not just a thin spike, then the photos is already quite damaged. Another
bad sign is if the middle part of the curve is quite flat or extremely ducked to the ground. If such histograms are produced
by a correction you did in LightMachine, you should correct your adjustment.

The RGB histogram also shows the darkest value (the end point of the curve at the left) and brightest value (the end point
of the curve at the right) in an image. Both are also called black point and white point. The range between both points is
called dynamic or tonal range and determines the contrast of the image. The optimal contrast is achieved if the curve
starts at the outer left and ends at the outer right. If that isn't the case, the image may not have a good contrast. If the
curve starts too more towards the middle, it also means that the image is too bright. If it ends more in the middle, then the
image is too dark.

Nevertheless there are always exception from the rule. A photo with a snow landscape will produce a similar histogram as
an overexposed photo, but the snow photo is fine while the overexposed photo needs to be fixed. On the other hand a
photo with a black sky and stars or the moon looks on the histogram as if it is underexposed, although that isn't the case.
So a good rule is to always investigate the image, too, and to not trust the histogram completely.

Small gaps tend do show up in the RGB Histogram more often than in other histogram types. They are only a sign that an
image was processed and are usually nothing to worry about.

Intensity, Luminosity and Lightness Histograms

The Intensity, Luminosity and Lightness histograms are very similar for many images. They often let you better judge the
brightness distribution in an image, but they are not suitable to judge blown highlights or cutoff shadows. If the image
contains more shadows, the hill is more on the left side. If it contains more highlights, the hill is located on the right side. If
it is well balanced, the hill or hills are usually in the middle of the histogram.

If there are two peaks, one on the outer left side in the shadows and one on the outer right side in the highlights, it means
that the photo was taken under extreme light conditions and contains too dark as well as too bright areas.

If there are peaks at both the outer left and right side, the image contrast is too extreme. In such a case you should
choose "Balance Midtones" from the Exposure Fix combo box or fine tune the image by using the Highlights and
Shadows sliders to compensate for it.

Red, Green, Blue, Cyan, Magenta and Yellow Histograms

These histograms can be used to recognize color casts or other color problems. For example if the Blue Histogram
contains a curve that is only located in the shadows, it means that there are as good as no light blue areas in the image.
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This can mean that the color blue was suppressed in the image and that the image has a yellow color cast.

Hue Histogram

The Hue histogram lets you see if some hues are missing. If some hues are dominant in the image, it can mean - but not
necessarily - that there is a color cast. A close-up photo for example is usually missing some hues even if it doesn't have
a color cast.

Saturation Histogram

The Saturation histograms lets you see if there is a problem with the saturation in the image. For example if there is
nothing in the left part, the image may be oversaturated or if there is nothing on the right side, the image is probably
undersaturated. However, images with a lot of white and dark areas may appear undesaturated according to the
histogram, but as pure white and black have no saturation, that may not be true.

Colors Histogram

The Colors histogram is similar to the RGB histogram, so it also lets you see if there are blown or cutoff areas.
Additionally it shows which hues are dominant in the shadows, midtones and highlights.

Black and White Histograms

LightMachine Manual 42



The left part of Black histogram and the right part of the White histograms are similar to the RGB histogram. Both
histograms should fill the whole value range from left to right for a good correction. The above Black histogram indicates
that the image is too "black" and too much "white" at the right end of the histogram is missing. The above White histogram
also has a larger gap at right end, which means that the white values aren't fully used.

If there is a large gap at the right or left end of the histogram, it means hat the contrast of the image is bad. Spikes at the
outer left or right indicate cut-off shadows and blown highlights.

Shadows and Highlights Histograms

The Shadows and Highlights histograms only take those image areas into account which are defined as shadows or
highlights by the mask controls in LightMachine. Changing the mask controls will also change the look of both histograms.
Both histograms are nice as a reference point when adjusting brightness and contrast in the shadows or highlights.

Styles

LightMachine lets you display the histograms in four different styles. "Filled" created the standard histogram type that is
known from many graphics applications. The "Gradient" option draws a color gradient from left to right. The colors of this
gradient are different from histogram to histogram. The "Line" option draws a line and leaves the area underneath empty.
"Dot" plots the histogram values as dots, which may make some histogram values less readable, but lets you easier
recognize a general trend.
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2.5 Info Tab

The Info tab shows information that is not essential but which may be helpful in certain circumstances.

Show Blown Highlights

If the Show Blown Highlights option is checked, highlight areas that were cutoff by LightMachine will be displayed as a line
pattern in the image. Additionally activating this check box shows a percent value in the check box label which indicated
the percentage of blown highlights. This feature doesn't show blown highlights that were already present in the image
before you executed LightMachine.

B/W

The B/W check box converts the image to black and white. This can help to see the tones in the image more clearly. It
can also be used to create B/W effects.

Color Box

When moving the mouse over the preview the color under the cursor is displayed in the color box of the Info tab sheet.
Additionally the color is shown as RGB and HSL values. The x and y values represent the image coordinates.

Bottom Lines

The two lines at the bottom of the Info tab sheet show the image size in pixel and the channel bit depth. The second line
only appears in the Standalone/Lightroom version and names the color space of the image or shows "No Profile" if no
profile was embedded in the image file.
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2.6 Prefs Tab

The Prefs tab contains some options for defining the behavior of LightMachine.

On Start Up

The default On Start Up control is "Previous Settings". This option will load the settings last used to correct an image with
LightMachine. The "Default Settings" option will set all controls back to default values, which deactivates the automatic
contrast and exposure correction. "Original Image" will start LightMachine with no correction applied to the image. The
"Logged Settings" option will automatically open the settings that were applied the last time to the same image. It only
works if you previously had the Log Settings check box activated and if you are using Photoshop or Paint Shop Pro (see
below for more information).

Language

The Language combo box lets you switch to another language. As a result all controls and messages in Lightmachine will
instantly appear translated to the selected language.

Skin

The Skin combo box features various skin options. Skinning means that the user interface receives a new look. There are
different options for imitating the user interface of Lightroom, Photoshop, Photoshop Elements, PaintShop Pro and Affinity
Photo. There is also a dark version of Aero (the default UI style of Windows Vista/7), a special PhotoWiz skin style as well
as an option to only skin the sliders. You can use a different skin for the plugin, standalone and Lightroom versions. The
None option of the Skin combo box recreates the standard controls and deactivates skinning, which requires restarting the
plugin or standalone.

Multi-CPU Off (x CPUs)

If you encounter any problems, you can deactivate the support for multiple processors and hyperthreading processors
with this check box. The number in brackets displays how many processors were detected. For example, for a
hyperthreading or dualcore processor you will see "2 CPUs" displayed. If you only have a non-hyperthreading, singlecore
processor, this check box will be disabled by default.

Instant Preview

If the Instant Preview check box is activated, you can drag a spot interactively over the preview in the Virtual Studio
modes. That makes it easier to place a spot, because you see its effect while you are dragging it. The preview is also
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updated while you drag a slider. Please notice that the Undo / Redo feature won't work anymore if you have this check
box activated.

This feature may work too slow on computers with an older processor. In such a case it is more convenient to deactivate
this check box.

Histo Zoom

Activating the Histo Zoom check box in the Prefs tab cuts off peaks for some images when displaying a histogram in the
Histo tab sheet. This avoids a flat histogram display where only a few high spikes are visible. That's also how Photoshop
displays histograms. This options is activated by default.

Log Settings

With the Log Settings check box activated LightMachine automatically saves preset files in the logfiles sub folder of the
LightMachine folder when you press the OK button to apply a correction to an image. In Photoshop and Paint Shop Pro
the presets are named with the file name of the image. In other applications a random number is used, because these
applications don't supply the file name of the image to plugins like LightMachine. If you apply LightMachine a second time
to the same image and have Log Settings activated, the previous preset file will be overwritten.

At least with Photoshop and Paint Shop Pro this feature allows you to easily find the settings that you applied to certain
images by looking into the logfiles sub folder. For other applications you can only look at the file date and guess which
preset files was used for which image.

In connection with the Logged Settings option of the On Start Up combo box (see above), you can use the Log Settings
check box to automatically make LightMachine start up with the settings that were applied the last time to the same
image. So if you need to correct the same image again, you will automatically be presented with the same settings that
you used the last time.

In case you don't want to start up LightMachine with the logged settings or forgot to activate that option, you can also
open the logged settings by right clicking on the Reset button and choosing "Logged Settings" from the context menu.
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2.7 Batch Processing

2.7.1 Scripting Or Cloak Mode?

The Plugin version of LightMachine 2 now offers scripting support in Photoshop, Paint Shop Pro and Debabelizer. This
means that you can record the effect settings in actions/scripts in these applications. The recorded action or script can
then be used for batch processing. LightMachine will automatically suppress the dialog and immediately render the effect
to the image. You need to record a new action or script for every LightMachine effect that you want to apply during batch
processing.

If you are using another application under Windows (e.g. Fireworks), the LightMachine dialog is not automatically
suppressed during batch processing. So you need to use Cloak Mode, which suppresses the dialog when activated. Corel
Photo-Paint on the other hand automatically suppresses the LightMachine dialog when called from a script, so you do not
need to activate Cloak Mode for it. In all of these cases you only need to record a single action or script with LightMachine
and can always use it during batch processing, because there are no effect settings recorded in the action or script.

Even if you are using LightMachine in Photoshop, Paint Shop Pro and Debabelizer, you can still decide to use Cloak
Mode. If Cloak Mode is activated, LightMachine will ignore the scripting values and apply the last used setting. Using
Cloak Mode has the advantage that you do not need to record a new action or script for every new LightMachine effect
that you want to apply, but you also always need to set a new effect in LightMachine before you can start with batch
processing.

If you want to use LightMachine as a smart filter in Photoshop CS3, CS4 and CS5, please deactivate Cloak Mode
before batch processing, otherwise LightMachine will not work properly as a smart filter.

2.7.2 Cloak Mode

If you decided to use Cloak Mode, you can activate it by holding down the CTRL key and clicking on the Cancel button.
The message box displayed below will appear. After pressing YES, the current settings will be saved and LightMachine
will be exited without rendering the effect to the image.

When you run LightMachine again by choosing it from the Filter menu of your image application, the dialog of
LightMachine won't show up and the previous settings will be rendered immediately to the image. So if you have the On
Start Up combo box on the Prefs tab sheet set to "Default Settings", this setting is ignored in Cloak Mode and the previous
settings are applied. However, if you have On Start Up set to "Logged Settings", LightMachine will search for
automatically logged settings for each image and apply them if they are available.

After you have processed your series of photos in Cloak Mode you can uncloak LightMachine again. To do that, keep the
the Shift key pressed down when selecting LightMachine from the filter menu in your image application. This will display
the LightMachine dialog again and exit Cloak Mode.

Alternatively you can also delete the file cloakfb.ini in the LightMachine folder. But this is just an emergency strategy.
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2.7.3 Batch Processing in Photoshop

Photoshop offers a Batch feature on its File > Automate menu. This feature lets you batch process a series of images with
the help of a Photoshop action. So if you want to batch process images in Photoshop you only need to record an action
that contains LightMachine.

Recording an action with LightMachine:

1. Open an image in Photoshop.

2. Switch to the Actions panel on the right and create a new action by using the New Action button or the pop-up panel
menu.

3. Choose LightMachine from the Filter menu.

4. Now adjust the effect settings in LightMachine, so that they are recorded in the action.

5. Press OK on the LightMachine dialog.

6. Press the Stop button on the Action panel. Now you have your LightMachine action that you can use with File >
Automate > Batch.
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Batch processing a series of images with LightMachine:

1. Open one of the images from the image series.

2. Select File > Automate > Batch.

3. In the Batch dialog make sure that your LightMachine action is selected.

4. Set the other batch options and click on OK to run it.

You can record a new action for each sharpening task that requires a different LightMachine effect. On the other hand if
you do not want to create a collection of different actions, you can also change the LightMachine settings that are
recorded in the action by clicking on the LightMachine item in the Actions panel, changing the settings in the appearing
LightMachine dialog and pressing OK. If you want to apply individual LightMachine settings to each image during batch
processing, please activate the small dialog icon next to the LightMachine entry in the Action panel. This will make the
LightMachine dialog appear for every new image.

On the other hand if you want to use LightMachine in Cloak Mode for batch processing a series of images, you only can
use any action that runs LightMachine. First run LightMachine, adjust the settings and activate Cloak Mode by holding
down the Ctrl key when clicking on the Cancel key. Then continue as mentioned above with Photoshop's Batch tool. To
uncloak LightMachine again afterwards please hold down the Shift key while running LightMachine from the menu.
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2.7.4 Batch Processing in Paint Shop Pro

Paint Shop Pro (Version 8 and higher) offers a Process feature on the File > Batch menu for batch processing a series of
images with the help of a PSP script. Recording such a script is quite easy.

Recording a PSP script with LightMachine:

1. Open an image in PSP.

2. Select File > Script > Start Recording.

3. Choose LightMachine from the Effects > Plugins menu.

4. Now need to adjust the effect settings in LightMachine, so that they are recorded in the script.

5. Press OK on the LightMachine dialog.

6. Select File > Script > Stop Recording and save the script. Now you have a LightMachine action that you can use with
File > Batch > Process.

Batch processing a series of images with LightMachine:

1. Open one of the images from the image series.

2. Select File > Batch > Process or File > Batch Process.

3. In the Batch Process dialog choose your LightMachine script with the Browse button from the Script frame.
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4. Set the other batch options and click on the Start button to run it.

You need to record a new script for every LightMachine effect that you want to apply during batch processing. You can
create a collection of scripts with various LightMachine effect and use these scripts as you need. If you want to apply
individual LightMachine settings to each image during batch processing, please deactivate the "Run script in silent mode"
check box in the Batch Process dialog. This will make the LightMachine dialog appear for every new image.

On the other hand if you want to use LightMachine in Cloak Mode for batch processing a series of images, you only can
use any script that runs LightMachine. First run LightMachine, adjust the settings and activate Cloak Mode by holding
down the Ctrl key when clicking on the Cancel key. Then continue as mentioned above with PSP's Batch Process tool. To
uncloak LightMachine again afterwards please hold down the Shift key while running LightMachine from the menu.

2.7.5 Batch Processing in Other Applications

There are some other applications that support batch processing with the help of plugins, e.g. Fireworks, Debabelizer and
Photo-Paint. Basically batch processing in other applications works the same as in Photoshop or Paint Shop Pro. In
Fireworks you need to record a script and use Cloak Mode for batch processing. In Photo-Paint you need to record an
script, but do not need to use Cloak Mode, because it already automatically suppresses the LightMachine dialog. If you
use LightMachine 2 in Debabelizer, you also do not need to activate Cloak Mode.
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2.8 Key Shortcuts

LightMachine lets you use a few key shortcuts for performing certain tasks. Some users usually prefer using key shortcuts
as they help to achieve some tasks much faster.

Please notice: If the input focus is resting on a combo box or edit box, please additionally hold down the ALT key,
otherwise the key shortcut will not work.

Here is a list of all shortcuts that can be used:

Ctrl and + Increases the preview zoom ratio

Ctrl and - Decreases the preview zoom ratio

Ctrl and 0 Set the preview zoom to Fit

Ctrl and 1 Set the preview zoom to 100%

R Resets some controls to their default values

P
(Windows only) Activates or deactivates the Auto Preview check
box

H Activates the hand tool

Space Activates the hand tool (Only if the mouse cursor is located over
the preview)

V Activates the cross tool

I Activates the eyedropper tool

S Activates the split view tool

Del or Backspace In Virtual Studio Mode: Delete spot

1 - 9, 0 In Virtual Studio Mode: Select spot Nr. 1 to 10.

Up, Down, Left or
Right

In Virtual Studio Mode: (If mouse is over the preview) Move
selected spot by 10 pixel

CRTL + Up, Down,
Left or Right

In Virtual Studio Mode: (If mouse is over the preview) Move
selected spot by 100 pixel

? (Windows only) Displays the manual
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B Displays a page with photos of the beta testers.
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3 Brightness/Contrast & Shadows/Highlights Modes

3.1 Brightness / Contrast

The controls on the first tab sheet at the top can be used to correct the whole image in the Brightness/Contrast modes,
adjust the shadows in the Shadows/Highlights modes, brighten or darken all spot lights in the Virtual Studio modes and
modify certain color areas in the Color modes. The controls on the third tab sheet are identical and let you adjust the
highlights or background areas.

Brightness

The Brightness slider doesn't work like the brightness or gamma sliders that are known from many graphics applications.
It doesn't cut off shadows or highlights and also doesn't change the contrast. Its algorithm was specially developed for
adjusting photos.

Its unit is EV (exposure values) and goes from -5.0 EV to +5.0 EV. Only very dark areas need an adjustment of +4.0 EV
or higher. Images with average shadows only need adjustments of +1 or +2 EV. Above +4.5 EV, most images starts to
lose too much contrast, so it is recommended not to use the highest value of +5.0 EV very often.

Contrast

The Contrast slider is much more sophisticated than any contrast features that are included with graphics applications.
Values below zero can make some details more visible, but can create a more grayish look. Values above zero increase
contrast and give the image more punch, but may make some shadow details less visible. Sometimes you have to reduce
the contrast to match the look of a brightened area with its surroundings.

Amplify

The Amplify slider is meant to be used in addition to the Brightness and Contrast sliders. It offers further precision for
brightness and contrast adjustments for difficult images. It performs a white point adjustment for positive values and a
black point adjustment for negative values. Please use with care, because it can easily blow highlights or suppress
shadows.

Local Contrast

If you drastically increase the brightness, an image can easily lose local contrast. That means the edges in the image get
brighter, too, and are less distinguishable from the plain surface areas. To compensate for that effect you can use the
Local Contrast slider. Try smaller values at first, because too high values may darken, desaturate or blow the highlights in
the image too much. The additional Radius slider controls the pixel size of the local contrast effect. A higher value affects
a larger image area. Using a Local Contrast adjustment can easily double the render time.



Local Contrast enhancement is basically sharpening with a high radius. Sharpening is usually applied with a low radius of
0.1 to max. 4.0 pixel whereas a radius of 8 to more than 1000 pixel is used for a local contrast adjustment. A local contrast
adjustment increases the contrast in an image whereas sharpening makes image edges more recognizable. Local
contrast enhancement and sharpening can be used in combination and don't exclude each other. However, I would only
use a Local Contrast adjustment if all other contrast adjustments fail like it is the case for extremely brightened up image
areas.
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3.2 Color

The controls on the second tab sheet at the top can be used to color correct the shadows in the Shadows/Highlights
modes, colorize all spot lights in the Virtual Studio modes and modify the color of certain color areas in the Color modes.
The controls on the fourth tab sheet are identical and let you adjust the color of the highlights in the Shadows/Highlights
modes and colorize background areas in the Virtual Studio modes.

Method

The Method combo box offers four methods that determine how the shadows or highlights will be color corrected with the
values from the Red, Green and Blue sliders.

Adjust

The Adjust slider lets you weaken or strengthen the effect of the Red, Green and Blue sliders. Values below zero produce
a weaker color correction and values above zero increase the color correction intensity. A value of -100 neutralizes the
Red, Green and Blue values, so that no color correction is applied.

Red, Green and Blue

You can use these sliders to set the color with which the shadows or highlights are corrected. Negative values select the
antagonistic color, which is Cyan for Red, Magenta for Green and Yellow for Blue.

The selected color is displayed in the box at the left of the three sliders. You can also double click this color box to choose
a color from a color dialog. The Red, Green and Blue sliders will than be adjusted accordingly.

Using the Eyedropper Tool

Instead of using the sliders or color dialog to set a color you can also use the eyedropper tool that is activated with the
appropriate icon above the preview. With the eyedropper tool you can click on the preview to choose a color.

In the Color modes the eyedropper tool simply lets you select a color from preview that will be added to the color box on
the tab sheet.. In the Shadows/Highlights and Virtual Studio modes the opposite of the selected color will be added to the
color box. As a result the shadows, highlight, spot or background areas are color correct semi-automatically. So best click
on an image area in the preview that you want to turn to white or gray.

The clicked color will be assigned to the color box that is activated. By the default the color box on the second tab sheet is
activated. If you want to assign a color to the color box of the fourth tab sheet, please switch to the tab sheet and click on
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the color box. Now you can click on the preview with the eyedropper tool. To switch back to the color box on the second
tab sheet click on it.

Saturation

The combo box at the left of the Saturation slider lets you choose the saturation method. "Saturation" is the standard way
of adjusting saturation, but it may add artifacts at higher Saturation slider values. "Median Sat.", "Lumi Sat." and "Average
Sat." usually doesn't do that. The six last options represent color filters that protect the saturation of the color they are
named after. For example, the "Yellow Sat." option keeps yellow objects from being saturated too much while saturating
other colors normally. It also prevents too much color noise appearing in those yellow objects.

Positive values of the Saturation slider increase saturation in the shadows or highlights whereas negative values reduce
saturation. For normal correction saturation increases or decreases between -20 and 20 are sufficient. Some shadow
correction may create a serious saturation or B/W increase. If you are not able to compensate for that effect with other
sliders, you should consider using higher values for the Saturation slider.

Dragging the Saturation slider to the outer left position turns the image to B/W. Together with the Sat. Method combo box
this is another way to create B/W variations of your image.
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3.3 Auto Mask

The Auto Mask tab sheet is a good starting place when adjusting the shadow/highlight mask. It basically does the same
job as the Light Mask method of the Fine-Tune tab, but offers a more structured approach. This makes it easier to use for
beginners, but it also allow a quick correction for pros.

N, P, S, H

If one of these four buttons is activated you will see the mask that is used for the correction in the preview. The N button
shows a negative view of the mask, the P buttons shows the positive version of the mask. The S buttons shows only the
shadow areas, spot areas or selected color areas depending on which mode you are currently using. The H button shows
the highlight or background areas.

If you have Split View and the Multiple check box active, you can use these four buttons to display the processed image
side by side with the mask.

Shadow Depth

Lets you define how deep or flat the shadows are in the image. If you only want to have the really black shadows lifted,
you should select "Very Deep" or "Deep". For many cases a "Normal" setting will do. If you want the lower midtones
brightened up, too, you can select "Flat". Including the whole midtones is seldom necessary, but you can do that by
selecting "Very Flat".

If some shadow areas still look too dark, or if a strange border appears in the image you should select a stronger option. If
some areas are brightened up too much, try a lower setting. The Shadow Depth feature adjusts the Threshold slider on
the Fine-tune tab sheet.

Image Type

Image Type only offers two choices: "Low Contrast" for images that have a soft brightness graduation and no hard edges
where very bright areas meet very dark areas. "High Contrast" images on the other hand have one or more regions where
bright areas meet dark areas without a smooth transition. The Image Type feature sets the Range slider of the Fine-tune
tab to zero for high contrast images and to 100 for low contrast images.

Anti-Halo

If you chose "High Contrast" in the Image Type combo box the Anti-Halo feature will appear, otherwise the Shadow Shift
combo box will replace it. The Anti-Halo combo box offers three methods for halo removal at various strengths. There are
basically only two methods plus both combined.

Halos are the bright glows that may appear where a bright image area meets a dark one. Method 1 tries to remove halos
by shifting the shadow/highlight border. It adjusts the Shift slider on the Fine-tune tab sheet. Method 2 tries to remove
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halos by blending them away. That can be quite effective in some cases, but may decrease the effectivity of the shadow
removal or highlight suppression. It adjusts the Anti-Halo slider on the Fine-tune tab sheet. The Combined options applies
both methods for the really tough cases.

Shadow Shift

If you choose "Low Contrast" in the Image Type combo box the Shadow Shift feature will be displayed, otherwise the
Anti-Halo combo box will appear. The Shadow Shift feature decreases the size of the shadow areas in the shadow mask
thus keeping some shadows areas from being brightened. Shadow Shift adjusts the Shift slider on the Fine-tune tab
sheet.

Details

The Details combo box smoothes the shadow/highlight border and also produces a light diffusion effect at higher settings.
Although it avoids hard edges in the image, it can also create halos at high contrast borders in the image. Using a lower
Details setting isn't usually the best solution, so you should set Image Type to "High Contrast" and use the Anti-Halo
feature.

If you have a very thin border between dark and bright areas in the image, it is better to use a "Very Fine" or "Fine"
setting. If the brightness gradiations in the image are larger and softer, you can also use a "Large" or "Very Large" setting.
The Details feature adjusts the Radius slider on the Fine-tune tab sheet.

Color Filter

The Color Filter feature lets you exclude image objects with certain colors from the shadows and add them to the
highlights. If you want to add certain colored image areas to the shadows, you have to select the antagonistic color from
the Color Filter combo box. For Red that would be Cyan, for Green it would be Magenta, for Blue it would be Yellow and
vice versa.

The Color Filter feature adjusts the Color Filter slider on the Fine-tune tab sheet.
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3.4 Fine-Tune / Reflection

The Fine-tune tab sheet from the Shadows/Highlights modes and the Reflection tab sheets from the Virtual Studio modes
are identical. The only difference is that the mask that is adjusted with the Fine-tune tab sheet separate the shadows and
highlights whereas the Reflection tab sheet controls the shape the spot lights. The adjustments of the Fine-tune tab sheet
in Shadows/Highlights (Pro) mode can be useful in Virtual Studio (Pro) mode and vice versa. LightMachine automatically
carries them over when switching modes.

N, P, S, H

If one of these four buttons is activated you will see the mask that is used for the correction in the preview. The N button
shows a negative view of the mask, the P buttons shows the positive version of the mask. The S buttons shows only the
shadow areas, spot areas or selected color areas depending on which mode you are currently using. The H button shows
the highlight or background areas.

If you have Split View and the Multiple check box active, you can use these four buttons to display the processed image
side by side with the mask.

Method

The Method combo box offers four choices for creating a shadows/highlight mask or reflection mask. The first three
options are simpler methods whereas the fourth "Light Mask" method is a combination of the previous three methods.
When using the Auto Mask tab sheet the Method feature is automatically switched to"Light Mask".

The Contrast Mask method was already used in the pre-digital days in photo labs. There are some Photoshop tutorials on
the web about it, but LightMachine uses a different and more effective technique that is closer related to the non-digital
method. An advantages of Contrast Mask is the good shadow recovery, but it tends to produce halo effects and also
brighten highlights. The Brightness Mask method works similar to the Shadow/Highlight tool from Photoshop. It's biggest
advantage is that no halos are produced at all. On the other hand it offers a less effective shadow recovery and brightens
highlights, too. The B/W Mask method, which is also used by some other plugins, offers the best shadow recovery and
doesn't brighten highlights, but like Contrast Mask it also tends to produce halo effects.

The Light Mask combines the advantages of the above mentioned methods. It features a very good shadow recovery,
doesn't brighten highlights and allows you to suppress halos. It also offers more features for flexibly adjusting the mask to
the image.

Stretch

The Stretch check box is activated by default, because it usually creates a stronger brightness correction by increasing
the contrast of the mask. Deactivating the Stretch check box can sometimes help when you use very high Radius sliders.
However, readjusting the Radius slider is sometimes the better alternative.
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Threshold

The Threshold slider lets you define the border between shadows and highlights in terms of brightness values from 0 to
255. If you split the brightness range into shadows, midtones and highlights, the shadows would run from 0 to 85 (255 / 3
= 85). So the Threshold value would have to be set to 85. This value works very nicely for many images. However, if an
image has deeper shadows, a value of 43 (which is approx. half of 85) may produce better results. If an image has
weaker shadows, a value of 128 may work even better. Only in few cases a value of 21 or 170 will work best.

Please remember, if you use a Threshold value of 85, the highlights will run from 86 to 255. If you only want lift the
shadows that value will be fine. If you want to adjust the shadows and highlights, a value of 128 may work better. If you
only want to target the highlights and leave the shadows untouched, you can also use a value of 170 or higher.

Range

If the Light Mask method is used, setting the Range slider to zero will keep the shadows and highlight areas separate from
each other. Higher values gradually blend the shadow and highlight areas together. With a value of 100 the shadows and
highlights will both be affected by the controls from the Shadows and Highlight (or Selected and Back) tab sheets.
Non-zero values are only recommended for images that have soft brightness graduations. This type of image looks better
if shadows and highlights aren't corrected separately.

For the Contrast Mask and Brightness Mask methods you should try keep the Range slider in the middle of the value
range, e.g. at 50. Higher or lower values usually have an adverse effect on the correction.

Shift

The Shift slider lets you shrink the shadow areas and enlarge the highlight area in the mask. It can be used to reduce
halos or to adjust the size of the shadows and highlight areas. A value of 100 will remove the shadows areas from the
mask.

Anti-Halo

As the name says the Anti-Halo slider is mainly intended for removing halos. A value of 1 already has quite some effect.
Values above 50 aren't really recommended, as they can weaken the correction.

Radius

The Radius slider smoothens the transition between shadow and highlight areas. Its maximum value changes from image
to image, because it is set according to the size of the image. Too high values will blend the shadow and highlight areas
too much. Too low values can produce hard edges. The Radius slider also determines the size of halos along high
contrast borders in the image. Nevertheless, it is recommended to lower its values. It is usually better to use the Shift or
Anti-Halo sliders. Using a very high radius value may also make halos less visible.

Lower Radius values are recommended for images with small and contrasty details. However, too high Radius values can
sometimes make a correction look unnatural. So you often have to choose the best compromise when setting the Radius
value.
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Color Filter

The Color Filter slider lets you choose the color which shall be excluded from the shadows and added to the highlights. If
you want to add image areas with a certain color to the shadows, you have to select the antagonistic color with the Color
Filter slider. For Red that would be Cyan, for Green it would be Magenta, for Blue it would be Yellow and vice versa.
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4 Virtual Studio Modes

4.1 Brightness / Contrast

The controls on the first tab sheet at the top can be used to correct the whole image in the Brightness/Contrast modes,
adjust the shadows in the Shadows/Highlights modes, brighten or darken all spot lights in the Virtual Studio modes and
modify certain color areas in the Color modes. The controls on the third tab sheet are identical and let you adjust the
highlights or background areas.

Brightness

The Brightness slider doesn't work like the brightness or gamma sliders that are known from many graphics applications.
It doesn't cut off shadows or highlights and also doesn't change the contrast. Its algorithm was specially developed for
adjusting photos.

Its unit is EV (exposure values) and goes from -5.0 EV to +5.0 EV. Only very dark areas need an adjustment of +4.0 EV
or higher. Images with average shadows only need adjustments of +1 or +2 EV. Above +4.5 EV, most images starts to
lose too much contrast, so it is recommended not to use the highest value of +5.0 EV very often.

Contrast

The Contrast slider is much more sophisticated than any contrast features that are included with graphics applications.
Values below zero can make some details more visible, but can create a more grayish look. Values above zero increase
contrast and give the image more punch, but may make some shadow details less visible. Sometimes you have to reduce
the contrast to match the look of a brightened area with its surroundings.

Amplify

The Amplify slider is meant to be used in addition to the Brightness and Contrast sliders. It offers further precision for
brightness and contrast adjustments for difficult images. It performs a white point adjustment for positive values and a
black point adjustment for negative values. Please use with care, because it can easily blow highlights or suppress
shadows.

Local Contrast

If you drastically increase the brightness, an image can easily lose local contrast. That means the edges in the image get
brighter, too, and are less distinguishable from the plain surface areas. To compensate for that effect you can use the
Local Contrast slider. Try smaller values at first, because too high values may darken, desaturate or blow the highlights in
the image too much. The additional Radius slider controls the pixel size of the local contrast effect. A higher value affects
a larger image area. Using a Local Contrast adjustment can easily double the render time.



Local Contrast enhancement is basically sharpening with a high radius. Sharpening is usually applied with a low radius of
0.1 to max. 4.0 pixel whereas a radius of 8 to more than 1000 pixel is used for a local contrast adjustment. A local contrast
adjustment increases the contrast in an image whereas sharpening makes image edges more recognizable. Local
contrast enhancement and sharpening can be used in combination and don't exclude each other. However, I would only
use a Local Contrast adjustment if all other contrast adjustments fail like it is the case for extremely brightened up image
areas.
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4.2 Color

The controls on the second tab sheet at the top can be used to color correct the shadows in the Shadows/Highlights
modes, colorize all spot lights in the Virtual Studio modes and modify the color of certain color areas in the Color modes.
The controls on the fourth tab sheet are identical and let you adjust the color of the highlights in the Shadows/Highlights
modes and colorize background areas in the Virtual Studio modes.

Method

The Method combo box offers four methods that determine how the shadows or highlights will be color corrected with the
values from the Red, Green and Blue sliders.

Adjust

The Adjust slider lets you weaken or strengthen the effect of the Red, Green and Blue sliders. Values below zero produce
a weaker color correction and values above zero increase the color correction intensity. A value of -100 neutralizes the
Red, Green and Blue values, so that no color correction is applied.

Red, Green and Blue

You can use these sliders to set the color with which the shadows or highlights are corrected. Negative values select the
antagonistic color, which is Cyan for Red, Magenta for Green and Yellow for Blue.

The selected color is displayed in the box at the left of the three sliders. You can also double click this color box to choose
a color from a color dialog. The Red, Green and Blue sliders will than be adjusted accordingly.

Using the Eyedropper Tool

Instead of using the sliders or color dialog to set a color you can also use the eyedropper tool that is activated with the
appropriate icon above the preview. With the eyedropper tool you can click on the preview to choose a color.

In the Color modes the eyedropper tool simply lets you select a color from preview that will be added to the color box on
the tab sheet.. In the Shadows/Highlights and Virtual Studio modes the opposite of the selected color will be added to the
color box. As a result the shadows, highlight, spot or background areas are color correct semi-automatically. So best click
on an image area in the preview that you want to turn to white or gray.

The clicked color will be assigned to the color box that is activated. By the default the color box on the second tab sheet is
activated. If you want to assign a color to the color box of the fourth tab sheet, please switch to the tab sheet and click on
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the color box. Now you can click on the preview with the eyedropper tool. To switch back to the color box on the second
tab sheet click on it.

Saturation

The combo box at the left of the Saturation slider lets you choose the saturation method. "Saturation" is the standard way
of adjusting saturation, but it may add artifacts at higher Saturation slider values. "Median Sat.", "Lumi Sat." and "Average
Sat." usually doesn't do that. The six last options represent color filters that protect the saturation of the color they are
named after. For example, the "Yellow Sat." option keeps yellow objects from being saturated too much while saturating
other colors normally. It also prevents too much color noise appearing in those yellow objects.

Positive values of the Saturation slider increase saturation in the shadows or highlights whereas negative values reduce
saturation. For normal correction saturation increases or decreases between -20 and 20 are sufficient. Some shadow
correction may create a serious saturation or B/W increase. If you are not able to compensate for that effect with other
sliders, you should consider using higher values for the Saturation slider.

Dragging the Saturation slider to the outer left position turns the image to B/W. Together with the Sat. Method combo box
this is another way to create B/W variations of your image.
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4.3 Spot Mask

N, P, S, H

If one of these four buttons is activated you will see the mask that is used for the correction in the preview. The N button
shows a negative view of the mask, the P buttons shows the positive version of the mask. The S buttons shows only the
shadow areas, spot areas or selected color areas depending on which mode you are currently using. The H button shows
the highlight or background areas.

If you have Split View and the Multiple check box active, you can use these four buttons to display the processed image
side by side with the mask.

Managing Spots

LightMachine lets you create an unlimited number of spots. There is already one spot, which can't be deleted, available
from the start.

To interaction with the spots you need to activate the cross tool above the preview. To create a new spot simply click with
the cross tool somewhere on the preview. Click where you want to have it placed. A new spot always has the properties of
the spot that was selected before the new spot was created. So if you want a new spot to have the properties of a existing
spot, select that spot first.

The currently selected spot is always surrounded by a marquee and has a broken-up rectangle around its center cross.
To select another spot simply click on its cross. Alternatively you can also use the numeric key to select one of the first 10
spots or use the Spot button menu (see below).

To drag a spot click on its cross and drag it by moving the mouse while keeping the left mouse buttons pressed. If the
mouse is placed over the preview, you can also move the currently selected spot by 10 pixel with the cursor keys. If you
additionally hold down the Ctrl key, the spot will be moved by 100 pixel. To delete a spot click the Del or Backspace key.

The spot that is selected can be adjusted with the controls from the Spot Mask tab sheet. If you want to adjust the
properties of another spot, please select that spot.
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The Spot Arrow-Down Menu

Clicking the small icon left of the Intensity slider displays the spot button menu. This menu contains commands for hiding
and showing spots, pasting spot properties to other spots and selecting spots.

The Hide Spots command hides the cross of each spot light and the surrounding circle of the currently selected spot light.
If you use too many spot light, these marks can obscure the image. So deactivating this button lets you see the image
more clearly. If you want to makes them visible again, the button menu will offer the Show Spots command.

The Paste to all Spots sub menu lets you transfer certain or all properties of the currently selected spot to all available
spots. This way you don't need to select each spot and adjust it individually if you want them to have the same properties.
The Paste All Properties To sub menu lets you transfer all properties of the currently selected spot to one of the other
spots.

Please remember that you only need to use these commands if all your spots are already created. Otherwise if you create
a new spot it will automatically get the properties of the selected spot.

The Delete Spot command deletes the currently selected spot. Alternatively you can also use the Del or Backspace key.

Finally, the Spot commands at the bottom of the menu let you switch between the available spots. Clicking one one of
the menu items will select that spot. The spots are numbered according to their creation time. The first spot that was
created is Spot 1, the second is Spot 2 and so on. Alternatively you can also select a spot with the numeric keys, which is
faster.

Intensity

The Intensity slider defines the intensity of the currently selected spot light. At a value of 255 the effects from the Spots
and S-Color tab sheets (e.g. brightness, contrast or color) are applied at full intensity to image areas that are covered by
the spot light. A value of zero deactivates the spot light. Values below zero turn the light spot into a shadow spot. At -255
the shadow spot has its highest intensity.

The effect of sliders on the Spots tab sheet (e.g. brightness and contrast) are uniformly applied to all spots. So the sliders
on the Spots tab sheet should be set according to the brightest spot. The other spots can be made darker by selecting
each one and decreasing the Intensity slider on the Spot Mask tab sheet.

Size

With the Size slider you can increase the size of the spot light in percent. The value refers to the width or height of the
image (whichever is smaller). That means can be maximally as large as the image itself. The relative value of this slider
means that you can use the same spots without any modifications with upsized or downsized versions of the same image.
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Ovality and Angle

The Ovality slider lets you turn the circular spot light into an oval one. The higher the Ovality slider the thinner is the
spotlight. The Angle slider only works if the Ovality slider is higher than zero. If the spot light is still totally circular, you can
see any rotation because of the symmetry of a circle.

At a Angle value of zero an oval spotlight is orientated vertically. To get a horizontal spotlight, you need to set Angle to a
value of 90.

Hardness

The Hardness slider makes the light of the spot harder, which means that the light is more concentrated on an area and
less diffused. At a value of zero the spot light has is brighter in the middle than at the border areas. Increasing the
Hardness of a spot light will make the middle areas brighter. The spot light appears bigger then, although it wasn't
enlarged. A higher Hardness value will also make the transition area between the spot light and the outer areas smaller
and less smooth. So a larger spot light is often a better alternative.

Reflection

The Reflection slider defines how much light is "reflected" from the image area that is covered by the currently selected
spot light. A value of 100 will "reflect" all light, which means that the image area will be brightened at full intensity. That
can easily produce blown highlight. The default value of zero often produces more natural results. Decreasing the
Reflection value up to -100 will decrease the reflection even more and keep already bright areas from being brightened.

You can adjust the reflection properties of the whole image by adjusting the controls from the Reflection tab sheet. The
settings of the controls on that tab sheet are applied to all spots and can't be set separately for each spot. These controls
are identical to those of the Fine-Tune tabs sheet of the Shadows/Highlights modes. It may be a good ideas to adjust
them in the Shadows/Highlights (Pro) mode and afterwards return back to the Virtual Studio (Pro) mode. With these
controls you can precisely reduce the reflection of highlight areas, reduce halos that are produced by spot lights and much
more.
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4.4 Fine-Tune / Reflection

The Fine-tune tab sheet from the Shadows/Highlights modes and the Reflection tab sheets from the Virtual Studio modes
are identical. The only difference is that the mask that is adjusted with the Fine-tune tab sheet separate the shadows and
highlights whereas the Reflection tab sheet controls the shape the spot lights. The adjustments of the Fine-tune tab sheet
in Shadows/Highlights (Pro) mode can be useful in Virtual Studio (Pro) mode and vice versa. LightMachine automatically
carries them over when switching modes.

N, P, S, H

If one of these four buttons is activated you will see the mask that is used for the correction in the preview. The N button
shows a negative view of the mask, the P buttons shows the positive version of the mask. The S buttons shows only the
shadow areas, spot areas or selected color areas depending on which mode you are currently using. The H button shows
the highlight or background areas.

If you have Split View and the Multiple check box active, you can use these four buttons to display the processed image
side by side with the mask.

Method

The Method combo box offers four choices for creating a shadows/highlight mask or reflection mask. The first three
options are simpler methods whereas the fourth "Light Mask" method is a combination of the previous three methods.
When using the Auto Mask tab sheet the Method feature is automatically switched to"Light Mask".

The Contrast Mask method was already used in the pre-digital days in photo labs. There are some Photoshop tutorials on
the web about it, but LightMachine uses a different and more effective technique that is closer related to the non-digital
method. An advantages of Contrast Mask is the good shadow recovery, but it tends to produce halo effects and also
brighten highlights. The Brightness Mask method works similar to the Shadow/Highlight tool from Photoshop. It's biggest
advantage is that no halos are produced at all. On the other hand it offers a less effective shadow recovery and brightens
highlights, too. The B/W Mask method, which is also used by some other plugins, offers the best shadow recovery and
doesn't brighten highlights, but like Contrast Mask it also tends to produce halo effects.

The Light Mask combines the advantages of the above mentioned methods. It features a very good shadow recovery,
doesn't brighten highlights and allows you to suppress halos. It also offers more features for flexibly adjusting the mask to
the image.

Stretch

The Stretch check box is activated by default, because it usually creates a stronger brightness correction by increasing
the contrast of the mask. Deactivating the Stretch check box can sometimes help when you use very high Radius sliders.
However, readjusting the Radius slider is sometimes the better alternative.
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Threshold

The Threshold slider lets you define the border between shadows and highlights in terms of brightness values from 0 to
255. If you split the brightness range into shadows, midtones and highlights, the shadows would run from 0 to 85 (255 / 3
= 85). So the Threshold value would have to be set to 85. This value works very nicely for many images. However, if an
image has deeper shadows, a value of 43 (which is approx. half of 85) may produce better results. If an image has
weaker shadows, a value of 128 may work even better. Only in few cases a value of 21 or 170 will work best.

Please remember, if you use a Threshold value of 85, the highlights will run from 86 to 255. If you only want lift the
shadows that value will be fine. If you want to adjust the shadows and highlights, a value of 128 may work better. If you
only want to target the highlights and leave the shadows untouched, you can also use a value of 170 or higher.

Range

If the Light Mask method is used, setting the Range slider to zero will keep the shadows and highlight areas separate from
each other. Higher values gradually blend the shadow and highlight areas together. With a value of 100 the shadows and
highlights will both be affected by the controls from the Shadows and Highlight (or Selected and Back) tab sheets.
Non-zero values are only recommended for images that have soft brightness graduations. This type of image looks better
if shadows and highlights aren't corrected separately.

For the Contrast Mask and Brightness Mask methods you should try keep the Range slider in the middle of the value
range, e.g. at 50. Higher or lower values usually have an adverse effect on the correction.

Shift

The Shift slider lets you shrink the shadow areas and enlarge the highlight area in the mask. It can be used to reduce
halos or to adjust the size of the shadows and highlight areas. A value of 100 will remove the shadows areas from the
mask.

Anti-Halo

As the name says the Anti-Halo slider is mainly intended for removing halos. A value of 1 already has quite some effect.
Values above 50 aren't really recommended, as they can weaken the correction.

Radius

The Radius slider smoothens the transition between shadow and highlight areas. Its maximum value changes from image
to image, because it is set according to the size of the image. Too high values will blend the shadow and highlight areas
too much. Too low values can produce hard edges. The Radius slider also determines the size of halos along high
contrast borders in the image. Nevertheless, it is recommended to lower its values. It is usually better to use the Shift or
Anti-Halo sliders. Using a very high radius value may also make halos less visible.

Lower Radius values are recommended for images with small and contrasty details. However, too high Radius values can
sometimes make a correction look unnatural. So you often have to choose the best compromise when setting the Radius
value.

LightMachine Manual 71



Color Filter

The Color Filter slider lets you choose the color which shall be excluded from the shadows and added to the highlights. If
you want to add image areas with a certain color to the shadows, you have to select the antagonistic color with the Color
Filter slider. For Red that would be Cyan, for Green it would be Magenta, for Blue it would be Yellow and vice versa.
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5 Color Modes

5.1 Brightness / Contrast

The controls on the first tab sheet at the top can be used to correct the whole image in the Brightness/Contrast modes,
adjust the shadows in the Shadows/Highlights modes, brighten or darken all spot lights in the Virtual Studio modes and
modify certain color areas in the Color modes. The controls on the third tab sheet are identical and let you adjust the
highlights or background areas.

Brightness

The Brightness slider doesn't work like the brightness or gamma sliders that are known from many graphics applications.
It doesn't cut off shadows or highlights and also doesn't change the contrast. Its algorithm was specially developed for
adjusting photos.

Its unit is EV (exposure values) and goes from -5.0 EV to +5.0 EV. Only very dark areas need an adjustment of +4.0 EV
or higher. Images with average shadows only need adjustments of +1 or +2 EV. Above +4.5 EV, most images starts to
lose too much contrast, so it is recommended not to use the highest value of +5.0 EV very often.

Contrast

The Contrast slider is much more sophisticated than any contrast features that are included with graphics applications.
Values below zero can make some details more visible, but can create a more grayish look. Values above zero increase
contrast and give the image more punch, but may make some shadow details less visible. Sometimes you have to reduce
the contrast to match the look of a brightened area with its surroundings.

Amplify

The Amplify slider is meant to be used in addition to the Brightness and Contrast sliders. It offers further precision for
brightness and contrast adjustments for difficult images. It performs a white point adjustment for positive values and a
black point adjustment for negative values. Please use with care, because it can easily blow highlights or suppress
shadows.

Local Contrast

If you drastically increase the brightness, an image can easily lose local contrast. That means the edges in the image get
brighter, too, and are less distinguishable from the plain surface areas. To compensate for that effect you can use the
Local Contrast slider. Try smaller values at first, because too high values may darken, desaturate or blow the highlights in
the image too much. The additional Radius slider controls the pixel size of the local contrast effect. A higher value affects
a larger image area. Using a Local Contrast adjustment can easily double the render time.



Local Contrast enhancement is basically sharpening with a high radius. Sharpening is usually applied with a low radius of
0.1 to max. 4.0 pixel whereas a radius of 8 to more than 1000 pixel is used for a local contrast adjustment. A local contrast
adjustment increases the contrast in an image whereas sharpening makes image edges more recognizable. Local
contrast enhancement and sharpening can be used in combination and don't exclude each other. However, I would only
use a Local Contrast adjustment if all other contrast adjustments fail like it is the case for extremely brightened up image
areas.
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5.2 Color

The controls on the second tab sheet at the top can be used to color correct the shadows in the Shadows/Highlights
modes, colorize all spot lights in the Virtual Studio modes and modify the color of certain color areas in the Color modes.
The controls on the fourth tab sheet are identical and let you adjust the color of the highlights in the Shadows/Highlights
modes and colorize background areas in the Virtual Studio modes.

Method

The Method combo box offers four methods that determine how the shadows or highlights will be color corrected with the
values from the Red, Green and Blue sliders.

Adjust

The Adjust slider lets you weaken or strengthen the effect of the Red, Green and Blue sliders. Values below zero produce
a weaker color correction and values above zero increase the color correction intensity. A value of -100 neutralizes the
Red, Green and Blue values, so that no color correction is applied.

Red, Green and Blue

You can use these sliders to set the color with which the shadows or highlights are corrected. Negative values select the
antagonistic color, which is Cyan for Red, Magenta for Green and Yellow for Blue.

The selected color is displayed in the box at the left of the three sliders. You can also double click this color box to choose
a color from a color dialog. The Red, Green and Blue sliders will than be adjusted accordingly.

Using the Eyedropper Tool

Instead of using the sliders or color dialog to set a color you can also use the eyedropper tool that is activated with the
appropriate icon above the preview. With the eyedropper tool you can click on the preview to choose a color.

In the Color modes the eyedropper tool simply lets you select a color from preview that will be added to the color box on
the tab sheet.. In the Shadows/Highlights and Virtual Studio modes the opposite of the selected color will be added to the
color box. As a result the shadows, highlight, spot or background areas are color correct semi-automatically. So best click
on an image area in the preview that you want to turn to white or gray.

The clicked color will be assigned to the color box that is activated. By the default the color box on the second tab sheet is
activated. If you want to assign a color to the color box of the fourth tab sheet, please switch to the tab sheet and click on
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the color box. Now you can click on the preview with the eyedropper tool. To switch back to the color box on the second
tab sheet click on it.

Saturation

The combo box at the left of the Saturation slider lets you choose the saturation method. "Saturation" is the standard way
of adjusting saturation, but it may add artifacts at higher Saturation slider values. "Median Sat.", "Lumi Sat." and "Average
Sat." usually doesn't do that. The six last options represent color filters that protect the saturation of the color they are
named after. For example, the "Yellow Sat." option keeps yellow objects from being saturated too much while saturating
other colors normally. It also prevents too much color noise appearing in those yellow objects.

Positive values of the Saturation slider increase saturation in the shadows or highlights whereas negative values reduce
saturation. For normal correction saturation increases or decreases between -20 and 20 are sufficient. Some shadow
correction may create a serious saturation or B/W increase. If you are not able to compensate for that effect with other
sliders, you should consider using higher values for the Saturation slider.

Dragging the Saturation slider to the outer left position turns the image to B/W. Together with the Sat. Method combo box
this is another way to create B/W variations of your image.
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5.3 Color Mask

N, P, S, H

If one of these four buttons is activated you will see the mask that is used for the correction in the preview. The N button
shows a negative view of the mask, the P buttons shows the positive version of the mask. The S buttons shows only the
shadow areas, spot areas or selected color areas depending on which mode you are currently using. The H button shows
the highlight or background areas.

If you have Split View and the Multiple check box active, you can use these four buttons to display the processed image
side by side with the mask.

Adding Colors to the Mask

The easiest way to add a color to the color mask is by using the cross key. After you activated the cross tool above the
preview, click on the preview to select a color that you want to add to the color mask. Now the Color combo box
automatically switches to this color and sets the Intensity slider to a value of 255. To remove a color from the color mask
again shift click with the cross tool on that color in the preview.

It works best if you select a color that is limited to a certain image area. Colors that are distributed over various image
objects and areas and without strict color borders are less suitable. Also, if an image has a color cast that spreads all over
the image can decrease the effectively of the Colors modes. In such a case it is best to correct the color cast at first.
However, if you only want to adjust the brightness and contrast of a color area, it don't matter much that much and even
overlapping color areas work fine. Using the Radius slider can help, too.

Color

The Color combo box lets you select the six main colors Red, Green, Blue, Cyan, Magenta and Yellow. The four sliders
beneath can have different values for each of the six color options. The slider values of each color option are used to
create a color mask.

Invert

The Invert check box lets you invert the color mask.
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Intensity

Defines how much the color that is selected in the Color combo box contributes to the color mask. If it is set to zero, the
image areas with that color are ignored. If it is set to 255, image areas with that color are added to the mask.

Impact

The Impact slider lets you intensify the selected color. It increases the contrast of that color in the color mask and
increases the intensity of the applied effect. Values up to 50 are recommended, but higher values may produce hard
edges in the image.

Radius

The Radius slider lets you smooth the individual mask of a selected color. This can be helpful to create a smooth
transition and avoid hard edges, but a too high value may also produce unwanted glow effects, so-called halos.

Range

The Range slider lets you shrink or expand the range of the currently selected color and exclude currently selected areas
or include other areas, too.
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